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[bookmark: _Toc229565465]ПРАВИЛА РАБОТЫ В ЛАБОРАТОРИИ
1. Правила работы в лаборатории при проведении лабораторных работ по дисциплине «Электротехника»
1.1 Общие положения 
Настоящие правила обязательны для исполнения всеми студентами, преподавателями и сотрудниками, находящимися в лаборатории.
Нарушение правил влечет за собой предупреждение, отстранение от работы и/или другие дисциплинарные меры, предусмотренные уставом учебного заведения.
Администрация лаборатории не несет ответственности за несчастные случаи, произошедшие в результате несоблюдения настоящих правил.
1.2 Инструктаж по технике безопасности
•	Перед началом каждой лабораторной работы студент обязан пройти инструктаж.
•	Инструктаж может быть как общим (в начале семестра), так и индивидуальным (перед каждой работой, если это необходимо).
•	Инструктаж включает:
Правила работы в лаборатории.
	Меры безопасности при работе с компьютерной техникой (электробезопасность, правильная посадка за рабочим местом, перерывы).
	Правила работы с программным обеспечением (особенно с незнакомым).
	Правила хранения и использования данных (конфиденциальность, резервное копирование).
•	Подтверждение прохождения инструктажа – подпись в журнале (при необходимости).
1.3 Меры безопасности
•	1.3.1. Общие требования:
	Поддерживайте чистоту и порядок на рабочем месте.
	Не оставляйте личные вещи на проходах и рабочих столах.
	Не употребляйте пищу и напитки за компьютерами.
	Не используйте постороннее программное обеспечение без разрешения преподавателя.
	Сообщайте о любых неисправностях оборудования или программного обеспечения лаборанту или преподавателю.
•	1.3.2. Электробезопасность:
	Не касайтесь оголенных проводов и поврежденных розеток.
	Не работайте с неисправным оборудованием.
	Не пытайтесь самостоятельно ремонтировать компьютерную технику.
•	1.3.3. Работа с компьютерной техникой:
	Соблюдайте правильную осанку при работе за компьютером.
	Регулярно делайте перерывы для отдыха глаз и разминки.
	Не перекрывайте вентиляционные отверстия на системном блоке и мониторе.
•	1.3.4. Работа с программным обеспечением и данными:
	Используйте только лицензионное программное обеспечение.
	Не устанавливайте программное обеспечение без разрешения преподавателя.
	Создавайте резервные копии своих данных.
	Соблюдайте конфиденциальность данных (особенно при работе с реальными данными о сотрудниках).
	Не распространяйте персональные данные без разрешения.
	Не посещайте сайты, содержащие вирусы или вредоносное программное обеспечение.
•	1.3.5. Профилактика компьютерных заболеваний:
	Регулярно проветривайте помещение лаборатории.
	Используйте средства защиты от излучения монитора (при необходимости).
1.4 Ответственность
•	Студенты несут ответственность за сохранность оборудования и программного обеспечения, предоставленных для выполнения лабораторной работы.
•	В случае повреждения по вине студента, он обязан возместить ущерб в установленном порядке.
•	Студенты несут ответственность за нарушение конфиденциальности данных.
2. Алгоритм проведения лабораторной работы 
по дисциплине «Электротехника»
2.1.	Подготовка к лабораторной работе:
o	Получение задания от преподавателя (описание задачи, данные, требования к отчету).
o	Изучение теоретического материала (конспекты, учебники, методические указания).
o	Ознакомление с используемым программным обеспечением (например, MS Excel, R, Python, специализированные HR-аналитические инструменты).
o	Подготовка плана выполнения работы.
2.2.	Начало лабораторной работы:
o	Запуск необходимого программного обеспечения.
o	Загрузка предоставленных данных или подготовка данных самостоятельно.
o	Создание новых файлов для хранения результатов работы.

2.3.	Выполнение работы:
o	Выполнение анализа данных в соответствии с заданием.
	Подготовка данных.
	Выбор и применение подходящих методов анализа (статистические методы, визуализация данных, машинное обучение).
	Интерпретация результатов анализа.
o	Фиксация промежуточных результатов.
o	Создание таблиц, графиков, диаграмм для визуализации данных.
o	Формулировка выводов и рекомендаций на основе результатов анализа.
2.4.	Завершение работы:
o	Сохранение всех рабочих файлов.
o	Закрытие программного обеспечения.
o	Удаление временных файлов (при необходимости).
o	Уборка рабочего места.
2.5.	Оформление отчета:
o	В отчете должны быть четко сформулированы цель работы, описание использованных методов, результаты анализа (с таблицами, графиками), выводы и рекомендации.
o	Отчет должен быть оформлен в соответствии с требованиями преподавателя.
o	Обязательно указывайте источники данных и использованного программного обеспечения.
2.6.	Защита лабораторной работы:
o	Демонстрация преподавателю результатов работы.
o	Ответы на вопросы по методике анализа, интерпретации результатов и сделанным выводам.
o	Объяснение ограничений использованных методов.
o	Предложения по дальнейшему развитию анализа.
o	Обоснование практической значимости полученных результатов
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	Визуальное моделирование динамических систем в среде MATLAB-Simulink.

Цель работы: изучение интерфейса и основных возможностей программного модуля Simulink и знакомство с разделами библиотеки SimPowerSystems, предназначенными для моделирования электроэнергетических объектов.
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Лабораторная работа № 2
	Моделирование линейных систем с использованием структурных блоков пакета Simulink

Цель работы: научиться моделировать и исследовать процессы в линейных системах при помощи S-моделей пакета Simulink.
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Лабораторная работа № 3
	Исследование аппарата (технологичесого процесса) как объекта автоматизации
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Лабораторная работа №4
Выбор комплекса технических средств системы управления
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Лабораторная работа №5
Разработка схем автоматизации
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Лабораторная работа №6
Разработка принципиальных электрических и пневматических схем питания приборов и средств автоматизации
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Лабораторная работа №7
Разработка схем внешних проводок
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Лабораторная работа № 8

[bookmark: _bookmark4]ВЫБОР ДАТЧИКОВ СЕНСОРНОГО УРОВНЯ АСУ ТП

1. Цель работы
[bookmark: _bookmark5]Цель работы
1. Ознакомиться с последовательностью выбора датчиков сенсорного уровня.
2. Освоить методику поиска датчиков сенсорного уровня АСУ ТП с использованием различных источников информации.
3. Получить практический навык принятия ответственного решения о соответствии прибора требуемым характеристикам и навык оформления кода заказа на средство измерения.

2. Теоретические сведения

	Эффективность системы автоматического управления всегда зависела от правильного и рационального выбора комплекса технических средств (КТС). Одной из важных задач систем автоматизации является получение и обработка информации в АСУ ТП, а также оперативное выполнение задач управления технологическим процессом на базе полученной информации, поэтому выбор технических средств должен производиться с учетом совместимости технических средств, модульности, надежности, максимальной эффективности и системного подхода [1]. При этом задача выбора элементов измерительного или управляющего комплекта обычно формулируется как задача поиска такого набора устройств, которые обеспечат минимальную стоимость комплекта при выполнении требований к точности и другим показателям (критерий выбора «цена – качество выполняемых функций»).
	Сенсорный уровень АСУ ТП состоит из технических средств, расположенных непосредственно на технологическом оборудовании или находящемся рядом с ним. Они включают в себя датчики (первичные преобразователи), исполнительные механизмы и устройства, межсистемные и нормирующие преобразователи, вспомогательное оборудование (конденсационные сосуды, вентили и т. д.).
	В данной работе затрагивается только четыре типа датчиков для измерения наиболее распространённых технологических параметров: температуры, давления, расхода и уровня.

2.1.	Последовательность выбора датчиков
	Независимо от типа параметра исходные данные при выборе датчиков идентичны. Это:
1)	диапазон изменения технологической переменной (технологического параметра);
2)	требуемая точность измеряемой технологической переменной, которая должна обеспечиваться комплектом технических средств, используемых в информационно-измерительном канале;
3)	информация об измеряемой среде, в которой будет находиться датчик (температура, давление, агрессивность и химическая активность);
4)	информация о внешней среде (пожароопасная или взрывоопасная среда, наличие магнитных и электрических полей, температура, запыленность, влажность);
5)	информация о расстоянии между местом установки датчика и местом расположения средства обработки данных (контроллера или УСО).
	Также при выборе датчика нужно учитывать его быстродействие (постоянную времени), надежность и другие показатели. После сбора исходных данных выбор производится в два этапа:
-	на первом этапе необходимо выявить все типы датчиков, имеющихся в базе технических средств автоматизации, диапазон измерения которых будет больше диапазона измеряемой технологической переменной (диапазон датчика берется на 20–30 % больше диапазона измеряемой переменной).
-	на втором этапе проверяется соответствие эксплуатационных характеристик выбранных датчиков условиям их использования на производстве (соответствие окружающей среды производственного помещения и среды, в которой будет находиться чувствительный элемент датчика). Датчики, условия эксплуатации которых не соответствуют требованиям (условиям, существующим на производстве), в дальнейшей процедуре выбора не участвуют. Из датчиков, которые удовлетворяют всем требованиям (в том числе по надежности, быстродействию и т. д.), выбирается датчик, имеющий минимальную стоимость.

2.2.	Рекомендации по выбору датчиков температуры
	При выборе датчика температуры необходимо обратить внимание на ряд вопросов.
1.	В каком температурном диапазоне Вы желаете измерять температуру, и какие допуски по точности измерений Вас устроят?
2.	Возможно ли будет расположить датчик внутри измеряемой среды или объекта? Если «нет», то Ваш выбор – радиационные пирометры.
3.	В каких условиях будет работать датчик (нормальных, повышенной влажности, высокой окислительной атмосфере, пожароопасных, сейсмоопасных и т. д.)?
4.	Возможно ли будет демонтировать датчик для периодической поверки и какая желательна долговременная стабильность?
5.	Какова должна быть взаимозаменяемость датчиков? Допустима ли индивидуальная градуировка?
6.	Актуально ли для Вас получение результата в градусах или Вас устроит измерение сигнала (сопротивление, напряжение, ток) с последующим самостоятельным пересчетом в температуру?
	Основные типы контактных датчиков температуры:
-	термометры сопротивления;
-	термопары;
-	термисторы;
-	полупроводниковые термометры;
-	биметаллические термометры;
-	жидкостные стеклянные термометры;
-	манометрические термометры;
-	кварцевые термометры. Существуют также:
-	магнитные термометры;
-	углеродные термометры;
-	стеклоуглеродные термометры и др.
	Существуют также:
-	магнитные термометры;
-	углеродные термометры;
-	стеклоуглеродные термометры и др.
	Сравнительная характеристика трех основных типов контактных температурных датчиков представлена в таблице 1.

	Классы точности (допуска) термометров сопротивления.
	В стандарте МЭК 60751 и в ГОСТ Р 8.625-2006 (введен в России с 1 января 2008) были приняты новые значения предельных отклонений ТС от стандартной функции «сопротивление-температура» (таблица 2). В классификацию допусков также были включены пленочные термометры сопротивления.


Таблица 1
Сравнительная характеристика трех основных типов контактных температурных датчиков
	Тип 
датчика
	Термистор
	Термометр сопротивления
	Термопара

	Параметр
	Электрическое
сопротивление
	Электрическое
сопротивление
	Электрическое
напряжение

	



Преимущества
	· Высокая чувствительность «сопротивление-температура».
· Малая инерционность.
· Высокое сопротивление, что устраняет необходимость четырехпроводного включения.
· Малый размер.
· Низкая стоимость.
· Высокая стабильность.
· Хорошая взаимозаменяемость
	· Хорошая линейность характеристики
· Высокая стабильность
· Высокая взаимозаменяемость в широком диапазоне температур
	· Широкий температурный диапазон
· Простота производства
· Низкая стоимость
· Износоустойчивость
· Не требует дополнительных источников энергии

	



Недостатки
	– Нелинейная характеристика
· Рабочий диапазон температур небольшой, примерно от -60 до +300 °С
· Взаимозаменяемость только в узком диапазоне температур
· Необходим источник тока
	· Низкая чувствительность
· Относительно большая инерционность
· Необходимость трех- или четырехпроводной схемы включения
· Чувствительность к ударам и вибрациям
· Необходим источник тока
· Высокая стоимость
	· Нелинейная характеристика
· Относительно низкая стабильность
· Низкая чувствительность
· Измерение низких ЭДС может осложниться электромагнитными шумами и наводками
· Необходима компенсация холодных спаев





Таблица 2
Предельные отклонения (допуская погрешность) ТС

	
Класс допуска
	

Допуск, °С
	Диапазон измерений, °С

	
	
	Платиновый ТС, ЧЭ
	Мед-ный ТС, ЧЭ
	Нике-левый ТС, ЧЭ

	
	
	Прово-лочный
	Пле-ночный
	
	

	1
	2
	3
	4
	5
	6

	АА W 0.1
F 0.1
	± (0,1+0,0017 | t |)
	От -50
до +250
	От -50
до +250
	-
	-

	А
W 0.15
F 0.15
	± (0,15+0,002 | t |)
	От -100
до +450
	От -50
до +450
	От -50
до +120
	-

	В
W 0.3
F 0.3
	± (0,3+0,005 | t |)
	От -196
до +660
	От -50
до +600
	От -50
до +200
	-

	С
W 0.6
F 0.6
	± (0,6+0,01 | t |)
	От -196
до +660
	От -50
до +600
	От -180
до +200
	От -60
до +180



Типы термопар и рекомендации по их выбору Тип J (железо-константановая):
· не рекомендуется использовать при температуре ниже 0 °С,
т. к. конденсация влаги приводит к образованию ржавчины;
· тип больше подходит для разряженной атмосферы;
· максимальная температура применения – 500 °С, т. к. выше этой температуры происходит быстрое окисление выводов; также выводы быстро разрушаются в атмосфере серы;
· показания датчика повышаются при термическом старении.
· сравнительно невысокая стоимость.
Тип Е (хромель-константановая):
· высокая чувствительность, что является преимуществом;
· термоэлектрическая однородность материала электродов;
· рекомендуется при использовании для низких температур.
Тип Т (медь-константановая):
· может использоваться ниже 0 °С;
· может использоваться в атмосфере как с недостатком кислорода, так и с его небольшим избытком;
· рекомендуется использование при температурах ниже 400 °С;
· не чувствительна к повышенной влажности.
Тип К (хромель-алюмелевая) – ТХА:
· используются в широком диапазоне температур, от – 100°С до +1000 °С (предел, зависит от диаметра термоэлектрода);
· недостаток при использовании диапазоне от 200 до 500 °С, так как возникает эффект гистерезиса, когда показания при нагреве и охлаждении могут различаться (разница до 5 °С);
· показания датчика снижаются при термическом старении;
· лучше не использовать в разряженной атмосфере, т. к. хром выделяется из Ni-Cr вывода из-за миграции, и термопара показывает заниженную температуру;
· выводы термопары быстро разрушаются в атмосфере серы.
Тип L (хромель-капелевая) – ТХК:
· характеристики этой термопары аналогичны термопаре типа K.
Тип N (нихросил-нисиловая):
· это новый тип термопары, реализованный на основе термопары типа К, которая легко загрязняется примесями при повышенной температуре; при сплавлении электродов с кремнием они загрязняются заранее, и риск дальнейшего загрязнения во время работы снижается;
· рабочая температура до 1200 °С (зависит от диаметра);
· рекомендуется использовать при температурах от 200 до 500 °С, где наблюдается высокая стабильность и меньший гистерезис, чем для термопары типа К;
· это самая точная термопара из неблагородных металлов.
Тип S (платнородий-платиновая) – ТПП:
· максимальная рабочая температура, которая рекомендуется, – 1350 °С; возможно кратковременное применение при 1600 °С;
· загрязняется при температурах выше 900 °С углеродом, водородом, металлическими примесями из железа и меди, поэтому такие термопары нельзя армировать стальной или медной трубками, или нужно изолировать электроды от трубки газонепроницаемой керамикой;
· может применяться в окислительной атмосфере;
· при температуре выше 1000 °С термопара может загрязняться кремнием, который присутствует в некоторых видах защитных керамических материалов; важно использовать керамические трубки, состоящие из высокочистого оксида алюминия;
· не рекомендуется применять ниже 400 °С, т. к. ТЭДС в этой области мала и крайне нелинейна.
Тип R (платнородий-платиновая) – ТПП:
· характеристики этой термопары аналогичны термопаре ти-
па S.

Тип В (платинородий-платинородиевая) – ТПР:
· максимальная температура, рекомендуемая для использования – 1500 °С (предел зависит от диаметра термоэлектрода), но возможно кратковременное применение до 1750 °С;
· при температурах выше 900 °С загрязняется водородом, кремнием, парами меди и железа, но меньше, чем термопары S и R;
· при температуре выше 1000 °С загрязняется кремнием, который присутствует в некоторых видах защитных керамических материалов;
· может использоваться в окислительной среде;
· не рекомендуется применение при температуре ниже 600 °С, где ТЭДС очень мала и не линейна.

Общие советы по выбору термопар из неблагородных металлов:
· ниже нуля – тип Е, Т;
· комнатные температуры – тип К, Е, Т;
· до 300 °С – тип К;
· от 300 до 600°С – тип N;
· выше 600 °С – тип К или N.
Классы допуска термоэлектрических преобразователей (термопар) по ГОСТ Р 8.585 представлены в таблице 3.

Таблица 3
Предельные отклонения (допуская погрешность) термопар
	Тип преобразо-вателя
	НСХ
	Класс допуска
	Рабочий диапазон температур,
°С
	Пределы допустимых отклонений от НСХ, ±°С

	
ТХА
	
K
	1
	от -40 до 375
	1,5

	
	
	
	св. 375 до 1100
	0,004 | t |

	
	
	2
	от -40 до 333
	2,5

	
	
	
	св. 333 до 1100
	0,0075 | t |

	ТХК
	L
	3
	от -40 до 360
	2,5

	
	
	
	св. 360 до 600
	0,7 + 0,005 | t |

	
ТПП
	
R, S
	1
	От 0 до 1100
	1,5

	
	
	
	св. 1100 до 1300
	1 + 0,0017(| t | -
1100)

	
	
	2
	от 0 до 600
	1,5

	
	
	
	св. 600 до 1300
	0,0025 | t |

	ТПР
	B
	2
	cв. 600 до 1600
	0,0025 | t |

	
	
	3
	от 600 до 800
	4,0

	
	
	
	св. 800 до 1600
	0,005 | t |





Краткие сведения по термисторам
Термисторы – это, по сути, термометры сопротивления, изготовленные из смешанных оксидов различных переходных металлов. Выделяется два типа термисторов:
· NTC – с отрицательным температурным коэффициентом сопротивления;
· PTC – с положительным температурным коэффициентом сопротивления.
Наиболее распространенный тип – NTC, а РТС термисторы используются в очень узких диапазонах температур, всего несколько градусов, в основном в системах сигнализации.
Большим преимуществом термисторов является разнообразие форм и миниатюрность. Основные конструктивные типы: бусинковые (0,1–1 мм), дисковые (2,5–18 мм), цилиндрические (3–40 мм), пленочное покрытие (толщина 0,2–1 мм). Выпускаются бусинковые термисторы диаметром до 0,07 мм с выводами толщиной 0,01 мм. Такие миниатюрные датчики позволяют измерять температуру внутри кровеносных сосудов или растительных клеток.
В основном выпускаются керамические полупроводники термисторов, изготовленные из гранулированных оксидов и нитридов металлов с последующим спеканием на воздухе при 1100–1300 °С и формированием сложной многофазной структуры.
	Номинальное сопротивление термисторов значительно выше, чем у металлических термометров сопротивления, оно обычно составляет 1, 2, 5, 10, 15 и 30 кОм. Поэтому для них может применяться двухпроводная схема включения.
	Исследования показывают, что бусинковые термисторы могут проявлять очень высокую стабильность (дрейф до 3 мК за 100 дней при 60 °С). Дисковые термисторы менее стабильны (дрейф до 50 мК за 100 дней при 60 °С).
	Термисторы представляют особый интерес для измерения низких температур благодаря своей относительной нечувствительности к магнитным полям. Некоторые типы термисторов могут применяться до температуры минус 100 °С.
	Наилучшая стабильность термисторов наблюдается в диапазоне от 0 до 100 °С. Также важными преимуществами являются малый размер, вибропрочность, малая инерционность и невысокая цена.

2.3. Рекомендации по выбору датчиков давления

Классификация датчиков давления
Давление – величина, характеризующая интенсивность сил, действующих на поверхность тела по направлению, перпендикулярному к этой поверхности. При измерении давления принято различать абсолютное, избыточное, атмосферное давление и вакуум. Основной единицей измерения давления является паскаль (килопаскаль – КПа, мегапаскаль – МПа), внесистемные единицы: 1кгс/см2=98 КПа, 1 мм вод. ст.=9,8 Па; 1 мм рт. ст.=133.33Па, 1 бар=100 КПа.
Следует иметь в виду, что все датчики давления измеряют разность двух давлений, воздействующих на чувствительный элемент датчика. Одно из этих давлений – измеряемое, второе – опорное, то есть давление, относительно которого происходит отсчет измеряемого. В зависимости от того, какое давление является опорным, различают следующие датчики давления:
· датчики абсолютного давления (РА);
· датчики избыточного давления (РИ);
· датчики давления-разрежения (РИВ);
· датчики гидростатического давления (РГ);
· датчики перепада давления (РДД).
Приборы для измерения давления могут классифицироваться по следующим характеристикам:
· по принципу действия;
· по виду измеряемого давления;
· по классу точности;
· по назначению.
По виду измеряемого давления приборы подразделяются на следующие:
-	вакуумметры;
-	манометры;
-	дифманометры;
-	напоромеры;
-	мановакуумметры;
-	тягомеры;
-	тягонапоромеры;
-	микроманометры;
· барометры.
По принципу действия основную группу преобразователей для измерения давлений можно подразделить на следующие:
· жидкостные;
· деформационные (пружинные);
· грузопоршневые;
· электрические и др.



Регламентируемые верхние пределы измерений или диапазоны измерений для преобразователей
ГОСТ 22520 регламентирует верхние пределы измерений или диапазоны измерений для преобразователей.
Разрежения: 0,06; 0,063; 0,10; 0,16; 0,25; 0,40; 0,60; 0,63; 1,0; 1,6;
2,5; 4,0; 6,0; 6,3; 10; 16; 25; 40; 60; 63; 100 кПа.
Избыточного давления: 0,06; 0,063; 0,10; 0,16; 0,25; 0,40; 0,60;
0,63; 1,0; 1,6; 2,5; 4,0; 6,0; 6,3; 10; 16; 25; 40; 60; 63; 100; 160; 250; 400;
600; 630 кПа,
1,0; 1,6; 2,5; 4,0; 6,0; 6,3; 10; 16; 25; 40; 60; 63; 100; 160; 250; 400;
600; 630; 1000 МПа.
Абсолютного давления: 1,0; 1,6; 2,5; 4,0; 6,0; 6,3; 10; 16; 25; 40;
60; 63; 100; 160; 250; 400; 600; 630 кПа,
1,0; 1,6; 2,5; 4,0; 6,0; 6,3; 10; 16 МПа.
ГОСТ 22520 регламентирует верхние пределы измерений преобразователей избыточного давления-разрежения.
С одинаковыми по абсолютному значению пределами:
0,05; 0,08; 0,125; 0,2; 0,3; 0,315; 0,5; 0,8; 1,25; 2,0; 3,0; 3,15; 5,0;
8,0; 12,5; 20,0; 30,0; 31,5; 50,0 кПа.
С различающимися по абсолютному значению верхними пределами: 60; 150; 300; 500; 530; 900 кПа; 1,5; 2,4 МПа, верхний предел измерения разрежения должен при этом соответствовать 100 кПа.

2.4. Рекомендации по выбору датчиков расхода и количества жидкостей, газа, пара
Расход вещества – это масса или объем вещества, проходящие через поперечное сечение трубопровода в единицу времени. Объемный расход (Fv) измеряется в (м3/сек), а массовый (Fm) – (кг/сек). Они связаны между собой зависимостью, аналогичной зависимости между массой и объемом Fm=Fv*ρ; где ρ – плотность вещества. Объемный расход связан со средней скоростью потока вещества (V) следующей зависимостью: Fv=V*S, где S – площадь поперечного сечения трубопровода.
Количество – это масса или объем вещества, проходящие через поперечное сечение трубопровода за определенный промежуток времени. Определяется в (м3) или (кг). Если количество вещества (в первую очередь газа, пара) определяется в единицах объема, то полученные результаты измерения необходимо корректировать с учетом его температуры, давления, плотности, вязкости. Это относится и к объемному измерению расхода вещества.
Прежде всего, следует различать приборы для измерения расхода и приборы для измерения количества, или расходомеры и счетчики. Рассматривая приборы, служащие для измерения расхода и количества веществ, представляется возможным классифицировать их по различным признакам. На рисунке 1 приведена классификация по принципу действия.
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Рис 1. Классификация средств измерения расхода жидкостей, газа и пара

По способам измерения расходомеры можно разделить на:
· расходомеры переменного перепада давления – приборы, принцип действия которых основан на измерении перепада давления на установленном внутри трубопровода сужающем устройстве; этот перепад давления служит мерой расхода протекающего по трубопроводу вещества;
· расходомеры обтекания – приборы, принцип действия которых основан на восприятии динамического напора протекающего по трубопроводу вещества чувствительным элементом прибора (поплавком, поршнем, гидродинамической трубкой и т. п.), помещенным в поток; в результате этот чувствительный элемент перемещается, и величина перемещения служит мерой расхода;
· расходомеры с непрерывным движением приемных устройств – приборы, чувствительный элемент которых под действием динамических усилий потока совершает вращательное или колебательное движения; скорость движения чувствительного элемента служит мерой расхода (вихревые);
· электрические расходомеры – приборы, принцип действия которых основан на измерении изменяющихся в зависимости от расхода электрических параметров системы: измеряемое вещество – чувствительный элемент прибора, величина какого-либо выбранного для измерения электрического параметра служит мерой расхода;
· тепловые расходомеры – приборы, принцип действия которых основан на измерении, служащего мерой расхода количеств: тепла, отданного каким-либо нагретым элементом потоку вещества;
· ультразвуковые расходомеры – приборы, принцип действия которых основан на измерении параметров ультразвуковых колебаний, распространяющихся в потоке измеряемого вещества.
Сравнительные характеристики и рекомендации для первых трёх типов расходомеров, наиболее используемых при автоматизации, представлены в таблице 4.

Таблица 4
Рекомендации по выбору наиболее распространенных датчиков расхода

	
	
	Измерение по перепаду давления
	Электромагнитные расходомеры
	Вихревые расходомеры

	Фаза среды
	Жидкость
	Да
	Да
	Да

	
	Пар
	Да
	Нет
	Да

	
	Газ
	Да
	Нет
	Да

	Условный диаметр*, мм
	0,5…2600
	2,5…400…
	15…400

	Макс. ско-
рость потока
	Жидкость
	Определяется типом устройства
	10 м/с
	10 м/с

	
	Пар, газ
	
	–
	80 м/с

	Температура раб. среды
	
мин., 0С
	Определяется длиной и температурным режимом импульсных трубок
	
-10
	
-200

	Минимальная
проводимость среды
	
	Не имеет значения
	5 мкСм/см
	Не имеет значения

	Особые среды
	Коррози-онно-
активные


	Затруднительно
	Да
	Возможно

	
	Вязкие
	Возможно
	Да
	Нет

	
	Пасты,
взвеси
	Не рекомендуется
	Да
	Нет

	
	Абразив-
ные
	Нет
	Да
	Нет

	
	Липкие
	Нет
	Да
	Нет

	Особые условия потока
	Пульсация
	Затруднительно
	Да
	Возможно

	
	Двуна-правленный
	Возможно
	Да
	Нет

	Макс. точ-
ность измерений
	Жидкость
	точность измерения перепада давления
±0,075 % от шкалы
	±0,5 % от тек. значения
	±0,75 % от
тек. значения



2.5. Рекомендации по выбору датчиков и преобразователей уровня жидкостей и сыпучих материалов
Датчики уровня жидкости предназначены для контроля уровня жидкостей в различных резервуарах. В датчиках уровня жидкостей используются различные методы измерения, которые являются основой при их классификации (рис. 2).
[image: ]
			Рис. 2. Типы датчиков уровня жидкостей

Механические уровнемеры – в которых измерение уровня производится одним из двух способов:
· поплавковые уровнемеры – по положению предмета на поверхности жидкости относительно двух точек измерений;
· буйковые уровнемеры – по измерению силы, действующей на буёк, погруженный в жидкость.
	Гидростатические датчики уровня измеряют давление столба жидкости, с последующим пересчётом его в значение уровня. По сути, являются дифференциальными датчиками давления, в которых измеряется давление среды и сравнивается с атмосферным. При емкости под давлением сравнение идёт не с атмосферным давлением, а с областью избыточного давления непосредственно в ёмкости. Применяются гидростатические датчики уровня для однородных жидкостей в резервуарах без существенного движения жидкости и могут использоваться для вязких жидкостей и суспензий, но в случаях, когда плотность жидкости не меняется в процессе измерения. Конструктивно эти датчики бывают двух типов: мембранные и погружные. Имеют высокую точность при простоте конструкции, и, следовательно, при невысокой стоимости.
Электрические уровнемеры. В них измеряемые значения уровня жидкости преобразуются в соответствующие электрические сигналы. Наиболее распространены емкостные уровнемеры и омические (кондуктометрические) сигнализаторы уровня.
Ультразвуковые уровнемеры – один из самых распространённых бесконтактных уровнемеров. Это акустический уровнемер, позволяющий измерять уровень в труднодоступных местах. Они зондируют рабочую зону волнами ультразвука с частотой свыше 20 кГц. Скорость распространения ультразвука зависит от температуры, поэтому требуется термокомпенсация с помощью датчика температуры. Рабочий диапазон до 25 м. Погрешности измерения 1 %. За счёт отсутствия контакта со средой используются для агрессивных сред, за исключением сильнопарящих и сильнопенящихся жидкостей, а также для мелкодисперсных и пористых сыпучих продуктов.
Радарные уровнемеры – это самые высокотехнологичные средства измерения уровня. Так же, как и ультразвуковые, они не имеют контакта с контролируемой средой и могут применяться для агрессивных, неоднородных, вязких жидкостей и для сыпучих материалов. Для зондирования рабочей зоны используется электромагнитное излучение сверхвысокочастотного диапазона. От ультразвуковых уровнемеров их отличает меньшая чувствительность к температуре и давлению и устойчивость к запыленности, пенообразованию и испарению. Радарные уровнемеры очень точны и позволяют производить измерения уровня сред с низкой диэлектрической проницаемостью и слабой отражательной способностью.
Измерение уровня сыпучих материалов. Характерное отличие сыпучих материалов от жидкостей – это непропорциональность давления, оказываемого на дно и стенки в зависимости от уровня контролируемого вещества. Поэтому почти все контактные методы не допустимы, и приходится использовать ряд особенностей. Самые дешевые, а, следовательно, и распространённые уровнемеры сыпучих материалов, соприкасающиеся со средой – лотовые уровнемеры. В них зонд, называемый лотом, и груз подвешены на блоке храпового колеса. Зонд через определённые интервалы времени приподнимается с помощью управляемого генератором импульсов мембранного привода и опускается на поверхность сыпучего материала под действием силы тяжести. Если уровень не изменяется, зонд поднимается и опускается на одно расстояние. При понижении уровня материала зонд опускается на большее расстояние, чем поднимается.

3. Порядок выполнения работы
В процессе выполнения работы необходимо выполнить 4 задания. При этом вариант для каждого задания один и тот же и выдаётся преподавателем.
Все 4 задания выполняются по очереди. При этом последовательность выполнения каждого из них идентична:
1. Записать в отчёт исходные данные соответствующие своему варианту в виде таблицы 5:
Таблица 5
Исходные данные для выбора датчиков температуры (давления, расхода, уровня)
	№ 
вар.
	Диапазон изменения температуры среды, 0С
	Требуемая точность измерения,
0С
	Среда, где необходимо установить датчик
	Характеристика внешней среды
	Требуемая надежность (время наработки на отказ и т. д.)

	…
	…. - …
	…
	….
	….
	….


2. Изучив рекомендации, представленные в разделе 2.2 (2.3, 2.4 или 2.5) и сопоставив их с исходными данными, выбрать подходящие методы измерения и типы чувствительных элементов. Запишите эти методы в отчёт.
3. Используя банк приборов кафедры, печатные каталоги и поисковую систему Internet, выберите не менее 5 датчиков, удовлетворяющих исходным данным. Параметры каждого датчика запишите в отдельные строчки указанной ниже таблицы:
Таблица 6
Выбранные датчики температуры (давления, расхода, уровня)

	№
	Наименование датчика, его тип и модель
	Пределы измерения
	Допустимая погрешность (класс точности)
	Расчи-танная абсолютная по
грешность
	Допустимые условия эксплуатации
	Выходной сигнал
	Примечание (доп. показатели)

	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	



4. Из получившегося списка выбрать два прибора, для которых было найдено боле подробное описание (желательно файл технической документации). Выбранные приборы должны быть различных производителей и при возможности иметь различные виды выходных сигналов. Отметить эти два прибора в таблице.
5. Для обоих выбранных приборов, опираясь на документацию (или страницы сайтов), необходимо вставить в отчёт несколько фрагментов, подтверждающие:
а) полное название средства измерения с указанием используемого метода измерения;
б) все требуемые характеристики прибора.
Сделать это нужно с помощью скринов (захвата области экрана), с последующей вставкой в документ и выделением важных частей красной рамкой, как это показано на рисунке 3.

Рис. 3. Пример фрагмента документации, подтверждающий требуемые характеристики выбранного прибора

6. Опираясь на исходные параметры точности и диапазона измерения произвести расчёт абсолютной погрешности каждого из 2-х приборов. Записать все расчёты в отчёт, а полученный результат в таблицу 2.
7. Проверить, соответствует ли рассчитанное значение погрешности и другие характеристики требуемым исходным данным. Если ни один из двух выбранных приборов не подходит, то необходимо повторить пункты 5 и 6 для другого, более точного прибора, пока не будет найден прибор, удовлетворяющий всем требованиям.
8. Для одного из выбранных приборов, у которого имеется подробная техническая документация, необходимо в виде скринов вставить в отчёт правила оформления кода заказа. И, опираясь на эти правила, составить полный код заказа, который также необходимо вставить в отчёт.
9. Записать вывод, указав, подходит ли выбранный датчик всем требованиям. Если же по каким-то причинам выбор произведён не до конца, то указать, какие характеристики не удовлетворяют требованию, почему, и как их возможно учесть.



4. Перечень заданий
Задание № 1. Выбрать датчики температуры, используя исходные данные, представленные в таблице 7 и рекомендации раздела 2.2, базу технических средств, каталоги и сеть Internet.

Таблица 7
Исходные данные для выбора датчиков температуры
	№ вар
	Диапазон изменения температуры среды,
0С
	Требуемая
точность,
0С
	Среда, где необходимо установить датчик
	Характеристика внешней
среды
	Требуемая надежность (время нар. на отказ)

	1
	20 – 80
	0,5
	молоко
	нейтральная
	2 года

	2
	5 – 120
	1
	молоко
	нейтральная
	2 года

	3
	-20 – (+10)
	1
	рассол
	нейтральная
	3 года

	4
	400 – 500
	1,5
	перегретый пар
	взрывоопасная
	3 года

	5
	100 – 200
	1
	пар водяной
	взрывоопасная
	3 года

	6
	2 – 90
	1
	вода
	нейтральная
	2 года

	7
	250 – 350
	1,5
	бензол
	пожароопасная
	3 года

	8
	150 – 320
	1,5
	масло технич.
	взрывоопасная
	3 года

	9
	40 – 120
	1
	циклогексан
	взрывоопасная
	3 года

	10
	300 – 500
	1,5
	топочный газ
	взрывоопасная
	3 года

	11
	120 – 200
	1,5
	воздух
	нейтральная
	2 года

	12
	10 – 90
	1
	cусло
	нейтральная
	2 года

	13
	160 – 280
	1,5
	газ природный
	взрывоопасная
	3 года

	14
	220 – 280
	1,5
	аммиак
	взрывоопасная
	2 года

	15
	550 – 700
	2
	коксовый газ
	взрывоопасная
	3 года

	16
	-10 – +50
	1
	рассол
	нейтральная
	2 года

	17
	2 – 30
	1
	молоко
	нейтральная
	2 года

	18
	200 – 550
	1,5
	топочный газ
	взрывоопасная
	2 года

	19
	-50 – (+50)
	1,0
	воздух
	нейтральная
	3 года

	20
	150 – 250
	1,5
	масло технич.
	пожароопасная
	2 года

	21
	15 – 70
	0,5
	вода
	нейтральная
	3 года

	22
	20 – 50
	0,5
	бензин
	пожароопасная
	3 года

	23
	200 – 300
	1,5
	перегретый пар
	нейтральная
	2 года

	24
	20 – 70
	1
	нефть
	пожароопасная
	2 года

	25
	3 – 40
	0,5
	кефир
	нейтральная
	2 года

	26
	90 – 120
	1
	пар
	нейтральная
	3 года

	27
	10 – 20
	0,5
	cок яблочный
	нейтральная
	2 года

	28
	50 – 70
	0,25
	пиво
	нейтральная
	2 года

	29
	-10 – (+5)
	0,25
	рассол
	нейтральная
	3 года

	30
	-80 – (-10)
	0,5
	воздух
	нейтральная
	3 года



Задание № 2. Выбрать датчики давления, используя исходные данные, представленные в таблице 8 рекомендации раздела 2.3, базу технических средств, каталоги и сеть Internet.
Таблица 8
Исходные данные для выбора датчиков давления
	№ вар
	Диапазон изменения температуры среды,
КПА
	Требуемая
точ-
ность, КПА
	Среда, где необходимо установить датчик
	Характеристика внешней
среды
	Требуемая надежность (время нар. на отказ)

	1
	200 – 290
	3
	cусло
	нейтральная
	2 года

	2
	200 – 390
	3
	бензин
	пожароопасная
	2 года

	3
	-20 – +40
(избыточного)
	2
	топочный газ
	нейтральная
	2 года

	4
	550 – 700
	4
	коксовый газ
	взрывоопасная
	3 года

	5
	-10 – +20
(избыточного)
	1
	воздух
	нейтральная
	2 года

	6
	100 – 200
	2
	cок яблочный
	нейтральная
	2 года

	7
	150 – 170
	2
	пиво
	нейтральная
	2 года

	8
	300 – 350
	4
	рассол
	нейтральная
	3 года

	9
	1200 – 1700
	6
	перегретый пар
	взрывоопасная
	3 года

	10
	-60 – (-10)
(избыточного)
	2
	воздух
	взрывоопасная
	3 года

	11
	1000 – 2000
	6
	пар водяной
	взрывоопасная
	3 года

	22
	900 – 1200
	5
	пар
	нейтральная
	3 года

	13
	300 – 500
	4
	масло технич.
	пожароопасная
	2 года

	14
	150 – 320
	3
	масло технич.
	взрывоопасная
	3 года

	15
	540 – 720
	5
	циклогексан
	взрывоопасная
	3 года

	16
	300 – 500
	3
	топочный газ
	взрывоопасная
	3 года

	17
	120 – 180
	2
	молоко
	нейтральная
	2 года

	18
	120 – 200
	2
	воздух
	нейтральная
	2 года

	19
	200 – 400
	3
	рассол
	нейтральная
	3 года

	20
	360 – 480
	5
	газ природный
	взрывоопасная
	3 года

	21
	220 – 280
	3
	аммиак
	взрывоопасная
	2 года

	22
	150 – 320
	3
	молоко
	нейтральная
	2 года

	23
	210 – 250
	3
	рассол
	нейтральная
	2 года

	24
	250 – 350
	4
	бензол
	пожароопасная
	3 года

	25
	150 – 400
	3
	вода
	нейтральная
	3 года

	26
	200 – 390
	2
	вода
	нейтральная
	2 года

	27
	600 – 800
	6
	перегретый пар
	нейтральная
	2 года

	28
	160 – 310
	3
	нефть
	пожароопасная
	2 года

	29
	150 – 240
	3
	кефир
	нейтральная
	3 года

	30
	220 – 300
	3
	молоко
	нейтральная
	2 года



	Задание № 3. Выбрать датчики расхода жидкостей и газов, используя исходные данные, представленные в таблице 9, рекомендации раздела 2.4, базу технических средств, каталоги и сеть Internet.
Таблица 9
Исходные данные для выбора датчиков расхода жидкостей и газов
	№ вар
	Диапазон изменения объемного расхода,
м3/час
	Требуемая
точность,
м3/час
	Среда, расход которой необходимо измерить
	Характеристика внешней
среды
	Требуемая надежность (время наработки на отказ)

	1
	10 – 100
	0,8
	воздух
	взрывоопасная
	3 года

	2
	21 – 25
	0,5
	рассол
	нейтральная
	2 года

	3
	100 – 200
	4
	масло технич.
	пожароопасная
	2 года

	4
	100 – 200
	2
	cок яблочный
	нейтральная
	2 года

	5
	450 – 600
	4
	нефть
	пожароопасная
	2 года

	6
	200 – 550
	4
	топочный газ
	нейтральная
	2 года

	7
	150 – 170
	2
	пиво
	нейтральная
	2 года

	8
	2 – 9
	0,2
	бензин
	пожароопасная
	2 года

	9
	600 – 800
	3
	перегретый пар
	нейтральная
	2 года

	10
	220 – 280
	2,5
	аммиак
	взрывоопасная
	2 года

	11
	500 – 800
	5
	пар водяной
	взрывоопасная
	3 года

	12
	120 – 200
	2
	воздух
	нейтральная
	2 года

	13
	20 – 40
	0,5
	рассол
	нейтральная
	3 года

	14
	12 – 18
	0,3
	молоко
	нейтральная
	2 года

	15
	260 – 380
	3
	газ природный
	взрывоопасная
	3 года

	16
	450 – 500
	4
	коксовый газ
	взрывоопасная
	3 года

	17
	-10 – +20
(избыточного)
	1
	воздух
	нейтральная
	2 года

	18
	2 – 3
	0,05
	молоко
	нейтральная
	2 года

	19
	200 – 390
	4
	вода
	нейтральная
	2 года

	20
	300 – 500
	3
	топочный газ
	взрывоопасная
	3 года

	21
	1,5 – 3,2
	0,05
	молоко
	нейтральная
	2 года

	22
	20 – 29
	0,6
	cусло
	нейтральная
	2 года

	23
	1000 – 1300
	6
	перегретый пар
	взрывоопасная
	3 года

	24
	50 – 120
	1,5
	вода
	нейтральная
	3 года

	25
	30 – 90
	1
	масло технич.
	взрывоопасная
	3 года

	26
	540 – 720
	5
	циклогексан
	взрывоопасная
	3 года

	27
	5 – 8
	0,1
	кефир
	нейтральная
	3 года

	28
	30 – 50
	1
	пар
	нейтральная
	3 года

	29
	50 – 70
	0,5
	бензол
	пожароопасная
	3 года

	30
	300 – 350
	4
	рассол
	нейтральная
	3 года





Задание № 4. Выбрать уровнемеры, используя исходные данные, представленные в таблице 10, рекомендации раздела 2.5, базу технических средств, каталоги и сеть Internet.
Таблица 10
Исходные данные для выбора уровнемеров и сигнализаторов уровня
	№ вар
	Диапазон изменения уровня жидкости,
мм
	Требуемая точ-точность,
мм
	Среда, уровень которой необходимо измерить
	Характеристика внешней
среды
	Требуемая надежность (время наработки на от-
каз)

	1
	50 – 550
	7
	бензол
	пожароопасная
	3 года

	2
	200 – 500
	8
	мука
	взрывоопасная
	3 года

	3
	0 – 400
	5
	вода
	нейтральная
	2 года

	4
	200 – 400
	10
	рассол
	нейтральная
	3 года

	5
	450 – 600
	4
	нефть
	пожароопасная
	2 года

	6
	1000 – 2000
	15
	селитра
	взрывоопасная
	3 года

	7
	0 – 3000
	20
	молоко
	нейтральная
	2 года

	8
	3000 – 5000
	30
	бензин
	пожароопасная
	2 года

	9
	0 – 1500
	20
	молоко
	нейтральная
	2 года

	10
	100 – 700
	15
	масло технич.
	взрывоопасная
	3 года

	11
	500 – 700
	15
	циклогексан
	взрывоопасная
	3 года

	12
	0 – 1000
	15
	молоко
	нейтральная
	2 года

	13
	200 – 2000
	20
	кефир
	нейтральная
	3 года

	14
	300 – 700
	5
	кисель
	нейтральная
	2 года

	15
	30 – 4000
	20
	пшеница
	взрывоопасная
	3 года

	16
	20 – 200
	10
	аммиак
	взрывоопасная
	2 года

	17
	200 – 700
	5
	сахар песок
	нейтральная
	3 года

	18
	20 – 800
	20
	рассол
	нейтральная
	2 года

	19
	200 – 400
	5
	cусло
	нейтральная
	2 года

	20
	1200 – 1700
	20
	песок
	нейтральная
	3 года

	21
	600 – 800
	7
	мука
	взрывоопасная
	2 года

	22
	100 – 200
	5
	масло технич.
	пожароопасная
	2 года

	23
	150 – 520
	5
	вода
	нейтральная
	3 года

	24
	20 – 2000
	10
	кефир
	нейтральная
	2 года

	25
	0 – 3000
	15
	воздух
	взрывоопасная
	3 года

	26
	500 – 2000
	8
	cусло
	нейтральная
	2 года

	27
	300 – 600
	3
	cок яблочный
	нейтральная
	2 года

	28
	100 – 1000
	5
	кефир
	нейтральная
	3 года

	29
	1000 – 3000
	10
	нефть
	пожароопасная
	2 года

	30
	1300 – 2000
	10
	кисель
	нейтральная
	2 года





5. Содержание отчета
1. Название и цель работы.
2. Номер варианта.
3. Результаты выполнения i-го задания (i – номер задания).
3.1. Таблица с исходными данными по выданному варианту.
3.2. Перечень методов измерения, допустимых в соответствии с исходными данными.
3.3. Таблица с перечнем выбранных датчиков и указанием всех их параметров (не менее 5 датчиков) и с выделением двух с полной документацией.
3.4. Скрин с указанием названия и метода измерения первого отмеченного датчика.
3.5. Скрины всех нужных характеристик первого отмеченного датчика с выделением рамками (или подчёркиванием) выбранных характеристик.
3.6. Расчёт абсолютной погрешности первого отмеченного датчика.
3.7. Скрин с указанием названия и метода измерения первого отмеченного датчика.
3.8. Скрины всех нужных характеристик первого отмеченного датчика с выделением рамками (или подчёркиванием) выбранных характеристик.
3.9. Расчёт абсолютной погрешности первого отмеченного датчика.
3.10. Скрины примера оформления кода заказа одного из выбранных датчиков.
3.11. Полный код заказа одного из выбранных датчиков.
3.12. Вывод о результате выбора датчика.
4. Повторить все пункты раздела 3 для всех 4-х заданий.


6. Контрольные вопросы
Контрольные вопросы по заданию № 1

1.1. Перечислите исходные данные, необходимые для выбора датчиков температуры.
1.2. Назовите основные типы контактных датчиков температуры.
1.3. Назовите основные критерии выбора датчиков.
1.4. Озвучьте рекомендуемую последовательность выбора датчика температуры.
1.5. Что такое стабильность и чувствительность датчиков температуры?
1.6. Перечислите основные типы контактных датчиков температуры.
1.7. Каковы преимущества и недостатки контактных датчиков температуры?
1.8. Перечислите не менее четырёх номинальных статических характеристики термометров сопротивления (НСХ ТС)?
1.9. Каковы преимущества и недостатки термопреобразователей сопротивления?
1.10. Укажите классы точности термометров сопротивления и в чем их отличие?
1.11. Перечислите не менее пяти термоэлектрических термометров.
1.12. Укажите преимущества и недостатки термоэлектрических термометров.
1.13. Для какой термопары нет необходимости термостатирования холодных спаев и почему?
1.14. Какие типы термисторов Вы знаете и в каких случаях их рекомендуется использовать?
1.15. Почему для термисторов можно использовать двухпроводную схему соединения с преобразователем, а для термометров сопротивления она не рекомендуется?

Контрольные вопросы по заданию № 2

2.1. Перечислите исходные данные, необходимые для выбора датчиков давления.
2.2. Чем отличается избыточное давление от абсолютного?
2.3. Какие используются единицы измерения давления?
2.4. Классификация датчиков давления в зависимости от опорного давления.
2.5. Классификация датчиков по виду измеряемого давления.
2.6. Как подразделяются датчики давления по принципу действия?
2.7. Назовите критерии выбора датчиков давления?
2.8. Охарактеризуйте термин «перенастраиваемость» датчика.

Контрольные вопросы по заданию № 3
3.1. Перечислите исходные данные, необходимые для выбора датчиков расхода жидкостей и газов.
3.2. Перечислите основные методы измерения расхода жидкостей и газов.
3.3. Классификация расходомеров в зависимости от типа выходного сигнала?
3.4. Какие преобразователи требуется использовать совместно с сужающим устройством?
3.5. Как произвести пересчёт объемного расхода в массовый?
3.6. Почему нельзя использовать для измерения расхода газа электромагнитный расходомер?
3.7. Перечислите основные типы массовых расходомеров.

Контрольные вопросы по заданию № 4
4.1. Перечислите исходные данные, необходимые для выбора датчиков уровня.
4.2. Какие методы измерения уровня жидкостей Вы знаете?
4.3. В каких случаях рекомендуется использовать гидростатические уровнемеры?
4.4. Каковы преимущества и недостатки гидростатических уровнемеров?
4.5. Назовите электрические уровнемеры и сигнализаторы уровня.
4.6. Каковы достоинства и недостатки электрических уровнемеров?
4.7. Каковы достоинства и недостатки радарных уровнемеров?
4.8. Чем радарные уровнемеры лучше ультразвуковых?
4.9. Где используются лотовые уровнемеры?
4.10. Перечислите основные отличия уровнемеров и сигнализаторов уровня
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3 O3HAKOMHTECA C OCHOBHEIMH OJ0KaMH pa3jiena Sinks (1lpuem-
‘winkn) GuGamorexn Simulink. Ha pucyrke 3 nokasansi Groku pasiena
Sinks, KOTOPHIC HCTIOMB3YIOTCA Kak 0O30pHbIE OKHA NIPH MOJCIHPORA-
Hun, OHH NO3BOIAIOT YIPABIATS MPOIECCOM MOZETHPOBAHIA, OGeCTIe-
“MBAIOT COXPAHEHHE NPOMEAKYTOUHEIX H HCXOAHBIX PE3YIETATOR MOZE-
posanns. Baoku pasiera SInkS HMEIOT TOJBKO BXOZSI H He HMEIOT
BIXOJI0B.

48 simulink Library Browser =B8] %
File Edi View Help

% 1 » Enersearch.. 44 &

Libraries Library: SimuinidSinks | Search R¢
4 Simulink

Commonly Used Blocks = (D)
Continaous
Disconinuties - Osky  Foung  ow
Disorets S
Logi and Bt Operations
Lookup Tales
Matn Operations B & &
Nodsl verieaton
Nodsi-Wide Uiies Scope Stp  Terminator
Pors & Subsysioms Smuaton
Sionl Afies
Siona Routng
g ] e ]
Sourzes
‘ ToFle o G
User-Dotied Functons. - WorSace
Showng: SmuinkiSiks
Prcynok 3

B nannoii naGopatopHoii paGore B KatecTae 0GIOPHEIX OKOH IPH
MOJEHPORANHH HCTIOTE3YIOTCS CIEAYIouHe GloKH pasaena Sinks:

— G0k Seope ¢ OIHIM BXOZOM — BHBOAHT B rpadiieckoe OKHO
TPAGUK 3ABHCHMOCTH OT BPEMEHH IOZABAEMOI Ha €10 BXOJL BEHAMHB;

— Guiok Display ¢ OAHIM BXOIOM — NpEAHAIHANEH JUIs OTOGpaKe-
IS THCICHHBIX 3HACHIT] BXOAHON BEIMHHIEL

4 O3makoMHuTECS ¢ ocHOBHEIMH GrioKaMM pariena Sources (Hc-
‘Tounkn) GuGanoTexi Simulink (pHeyHOK 4), KOTOPHIE IpeAHA3HAUCHE!
15 (JOPMMOBAHUS BXOAMMIX CHIHAIOB W OGCCHICMHBAIOT pagoTy
S-MOZEIM B LENOM WIH OTACTEHAIX ee 4acTeli MPH MOZEIHDOBAHHI.
OHH MEIOT N0 OZHOMY BEXOZY, HO HE MMCIOT BXOIOB. Baoki-
HCTOMHMKH MOTYT HACTPAHBATHCS TIO/TB3OBATEIIEM.
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Library: Simulink/Sources | Search Resulls: (none) | Frequently Used

s} [} [wweema} [Comn = >
Digital Enumerat-  From File From Ground in1
Clock ed Const. Workspace

T4 S M A
Puse Ramp  Random Repeating Repealing Repeating

Generator Number Sequence Sequenc.. Sequenc.

B~ o M

Signal Signal  SineWave  Step Uniform

Builder  Generator Random.
Pucynok 4

B zaunoii naGopatopHoii paGote GyIyT HCNIONEIOBATECA CCAYIO-
[ ——

— Sine Wave — resepHpyer HenpepsBHbLii rapyomieckiii CHra;

~Signal Generator — cosuaer HempepuBHbi KoneGatebHbtit
CHIHAT OZHOT W3 (JOPM: CHHYCOQILHO, NIPAMOYTOILHOI, TPeyrob-
Hoii ik caysaiioli;

— Pulse Generator — resepHpyeT HenIpepLBHALi NPAMOYrOMsHELi
cnrman;

— Constant — reHepUpYeT CHIHAL, IOCTORHHBII 110 BPGMEHH.

S Toctpouts, Giok-cxeMy S-wojte, conepameil crenyioume
Gaoku GuGanorexi Simulink: Sine Wave u3 pasiena Sources, xudie-
penumpylouwii 6ok Derivative u3 payiena Continuous i Scope n3
pazena Sinks (pcyHoK 5).

JloGasuts GOK MOHO ¢ HOMOIIBIO Komarst Add to (Mwst Mo~
Je:1H) KOHTEKCTHORO MeHIO, BEIIMIBICMOTO HAAKATHEM NPABOIi KHOIIKH
sabiit (TTKM), i1 nepeTackianien G110k MEKy OTKDBITBIMM OKHA-
MM Tpi HakaTOli 1eBoii Ko M (JIKM).

Ecam TpeSyercs pateephyTh GIOK, TO HYKHO BHICTHTE GIOK,
naath [TKM M BHIGPATS B IOSBHBLICMCS KOHTEKCTHOM MEHIO KOMANY
Rotate&Flip, K0T0pas HMEET HECKOEKO BAPHANTOR HCIIOMHEHHS:

—Clockwise - pazaopor Giioka Ha 90° 1o “acomoil cTpenke
(Ctrl+R);

— Clockwise - passopor Gioka Ha 90° npoTis 4acooii cTpenki
(Curl+Shift+R);
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~ Flip Block — passopor 6110ka B ipyryio cropoy (Ctrl+1);
~ Flip Block Name — niepenoc Hanmiuch ¢ Apyroii CTopowi G1oka.

Fle Edt View Display Disgram Simuation Analyss Code Tools Help
%-@ SHe-BIOP = ©- w

Wodelsrowser <= | modelt

durdt b Scope

Derivative

Ready 175% odeds

Pucysok §

Jlns coexumenis Meakty Gokavi HykHo Haats JIKM Ha Goke-
HeTodmMKe 1, yiepausas kuomky Ctrl, maxars JIKM ma Grioke-
npHeMiKe WM npoTauTh Hakaryio JIKM 0T BHXOAa 0AHOTO GlioKa
K BXOAY ApyrorO.

5.1 Bunomants agoiiuoii mexox mo Gioky Sine Wave u ycraro-
BHTE B NOABMBILIGMCS OKHE CBOHCTB CACAYIOILUAE SHAUCHIS:

— amnuTy1a rapoRieckoro curiata Amplitude —

— CMelIieHHe 1IH NOCToRHA cocTapIAIomas Bias - 0;

— wactora koneGauuii o, pax/e Frequens (rad/sec) - 1;

— nasansuas dasa, pax Phase - 0.

Tak KaK MOZCIMDYSTCA HENDEPHBHAS CHCTEMA, TO YCTAHORIM
MaveHHe WAra MOZEIEHOTO Bpemeni Sample time — 0. [Tk Moze-
poain AHcKpeTHEIX cuerem Sample time > 0. TTpn Sample time = -1
IMAYCHHE LIAra MOACTLHOTO BPEMEHH YCTAHARTHBACTCS TAKHM e, KiK.
B npesiyIen Goke. Bee OCTATBHbIE YCTAHORKH B OKHE CBOIICTS 610~
xa Sine Wave ocrasiTs Ge3 iiveHenis.

5.2 Bunommts Apoiinoii wenok no Gioky Scope. B pesyirare
OTKPOSTCS! OKHO Seope, JUis HACTPOIiKH CBOIICTE KOTOPOrO HEOGXOMIMO

WakaTs a ero nasem wCTpyMeTos kiomky O . B pesynurare or-
KPOCTCs AWMAIOrOROE OKHO ‘Scope’ parameters (PHCYHOK 6), Ha BKIZ-
Ke General KOTOPOO HEOGXOTHMO 37T CIEIYIOUIHE 3HAYCHA NIApa-
MeTpos:

— komectso rpaduseckix noieli Number of axes:





image7.png
— BepXHAA IPAHHIA MOJENLHOTO BPEMEHH, OTKIABIBAEMOrO 110
ocit abewnee Time range: — 2*pi (ONpeACIM HCXOL 3 JVIAHHOTO
auaseHIt YrIioBoil sacToTht 6710ka Sine Wave @ = 2nf=2n/T = 1 pakc,
MTO COOTRCTCTBYCT NEpHOTY TAPMOMINECKOTO CHTHTA B COKYHAAX
T=2w0=2m1=2n);

— nozmic 1 Beex oceii Tick labels: — all

Bl ‘Scope’ parameters [~

Gensral [ History Style

Axes
Number of axes: 2 Floating Scope
Time range: 2'pi [ Legends

Tick labels: |bottom axis only v

Samping
Decimation | 1

OK | [ cancel | | Help | | Apply

Pucysox 6

ClieayeT WMETh B BILAY, HTO €CAH PAIMEP JALAHHOTO MHTEPBAIA
Mozeanposauis Tw Gyer yeranonen Gobie uauens Time range,
10 & oxiie Scope GyAeT OTOGpaKeH TOILKO rpadiik, cooTBeTCTRYIOUH
noceeMy OTpesky Bpemenn, pastosy Tv —n* Time range, e n—
Liesoe 4mco.

BuGpars & okne ‘Scope’ parameters i3 ciicka Sampling (Tuc-
kpeTusawis) suasenne Decimation (ITpopeHsaie) W 31aTh B COCel-
HeM NpaBoM OkHe mavenie «1», 060IHAAONIEE KONHHECTRO HHTEPBA-
J10B JMCKDETH3AIIMM, Yepe3 KOTOPHIC MONYHHHEIS JAHHBIC MOXCIH-
POBaHMA GYIyT HCTIOTB3OBATHCH A NOCTPOHMA rpagkos. Ecm
& cincke Sampling BuGPaTh 3nauenue Sample time, To B cocexuen
1IPABOM OKHE HEOBXOAMMO YKA3ATH IPOMEAKYTOK BEMeHH, KpATHSIi M-
TepBATY AMCKPETHIALIHMH, HEPe3 KOTOPBLH MO/yHeHHEI JAHHBIE MOZEIH-
POBHIS GYAYT HCTIONE3OBATECA /UIS TIOCTOGHHS TPAGUKOB.

Komansi wa pnazke History b okie ‘Scope’ parameters (pucy-
HOK 7) NIOIBOISIOT 3IATH MAKCHMATBHOE KOTHYECTBO YICMEHTOB MAC-
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CHBA JIAHHBIX, HCIIOJIB3Y@MBIX JUIA IIOCTpORHHUS Tpadukos. [laumsie, Ko-
TOphie HCNOAB3YIOTCS IS NOCTpOCHHS IPAQUKA B OKHE SCOpe, MOAHO
3anucats » paouce npoctpancrao MATLAB, ecun yeranomnts duia-
ok Save data to workspace. Tlpi 51om & nose Variable name (s
IepeMeHHON) MOKHO HIMCHHTH MM UeMEHHO, 4 B moAe
Format (oopmat) BHGPATE OZMH 3 TpeX (IOPMATOB JAIHCH JAHHBIX:
Array (Maccus, marpiia), Structure (Crpykrypa) i Structure with
time (CrpykTypa ¢ Bpemeney).

B ‘Scope’ parameters [

General H History | Style|

[¥] Limit data points to last: 5000

[7] Save data to workspace
ScopeData

Structure with time -

Pucynok 7

Komanst na sknazke Style  okue ‘Scope’ parameters (pucy-
HOK 8) 1103B0IIOT 34Tk UBeT U1 ryphL, oA I ocel, THII, ToMIH-
Hy M BT JMHMH, THII MADKEPA B TOMKAX AMCKPETHIALMH, HCTIOME3Ye-
MBIX U1 IOCTpOCHIS IPAHKOB B OKHe Scope.

Veranosurs Gemsii wser duryps Figure color: it dona Axes col-
., a user oceii — uepusim. 3azath B obnacTH Line: s obenx mmnii
Tomy 2 i uepHii uaeT.

5.3 CoexmnuTs 610K MeALy COGOH B COOTBTCTRMH C PHCYH-
koM 9. Ui 5TOTO YCTAHORHTE YKAIATE.lh MBILIN B OB/IACTH BHIXOZHOTO
nopra Gioka Sine Wave (Ipi 5T0M YKa3aTelh IPHHIMACT BHA KDECTH-
Ka) H, ylepamas Haxatoii JIKM, IepeMECTHTS YKataTellh K BEPXHEMY
BxozHOMY nopTy G10Kka Seope. Tlociie OTIYCKANHS KHOIKH MBI 10~
SBHTCS JMHHS CBA3 CO CTPEIKOI K KOHIlE, yKasIBaioleli Hanpasie-
Hme nepexaun curnana. Hipkuuii BX01HON NOPT Glioka Seope coelu-
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HIHTE C BRIXOAHEIM NopTOM G10ka Derivative. Bxoauoii nopr Gaoka De-
rivative HABECTH 1A HYAHOE MECTO NICPROI| JIMHIH CBSIM IPH HAKATON
JIKM 1 OTIyCTHTE. B Pe3y/IbTATe Ha MHIH CBAIM IOSBHTCS YIEI B BH-
e TouKH.

B ‘Scope’ parameters =

Genera History Sl
Figure calor: (& <] Aves colors: (& -] [

Properties for lne: 1 v

Line: | —— v|2

Marker: none ¥

Pucynox §

P

Sine Wave

p‘duldl Scope

Derivative

PucyHok 9

5.4 Tlepex 3anyckoM monyHenHOl G10K-CXeMb Ha MOACTHPOBHHE.
CHAMAIA HEOBXOMMMO YCTAHOBHT TPEGYEMBIE IIAPAMETPE MOJCIHPORA-
wis, BEGPaR kowaizy Simulation=>Model Configuration Parameters

i s wa maeas wrpywetos xaasnry . B pesymrare or-

KPOETC OKHO HACTPOHKi MapaveTpos, rpyma SolVer KOTOpOro moka-
sana wa pucynke 10.
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£ Contgurston Prameers: e 1 Configurston (cive)

‘Simulation time
Start time: 0.0 ‘Stop time: 2*pi
‘Solver options.
Tpe: Veriablestep SlScire: e
Maxstep size:  auto Relative tolerance: 13
Min step size:  auto Absolute tolerance: auto
Initial step size: auto ‘Shape preservation: Enable
NNumber of consecutive min steps: 1

Q9 oK. Cancel |[ Help || A

Pucynox 10

3azats B oGaactu Simulation time 3MAYCHHs HAYATEHOTO BpeMe-
i Mozenmposanis Start time: 0.0 1 KOHEHHOIO BPEMEHH MOACTHPO-
anns Stop time: 2*pi. Bemiuina KOHEUHOTO BpeMHH BHOpAHA H3
YCAOBHS NPOBECHIS MOZEIHDORAHHS B TEEHHE OIHOTO MEPHOA Tap-
MOHIHECKOTO CHIHAIA, YACTOTA KOTOPOTO B PACCMATPHBACMOM CIydae
panna | pae. OAHAKO CICAYET HMET B BIIY, 4TO Tekylee (Bisuse-
CKOE BpEMs H BPEMS MOACTHPOBANHS He ABIFIOTCA OAHHAKOBKIMH IIOHS-
‘TisiH. BpeMs MOACTHPOBAHHS JABHCHT OT CAOKHOCTH MOJEIH, METOAA.
petlienis i GHICTPOZCIiCTRIS KOMITBIOTEpA.

BHIGOp METOAa MOACTHPOBANHS M €r0 NAPAMETPOR OCYLIECTRIIS-
eres B oGact Solver options.

Omuns Type: 5azaet THr petmenis:

¢ nepenentsi waron (Variable-step), koropsii pexosenyer-
5 1IpH PACHETE HTIPEPHIBHAIX CHCTEM;

¢ dukcnposannsi marom (Fixed-step), KoTOpaiii pexoveray-
€TCH pH PACHETe AMCKPETHBIX CHCTEM.

JlysIume pesyIsTATE HALe BCErO A9€T POIICHHE C NEpeMeHHbI
LATOM, TAK KK NPH YBCNHHEHMH CKOPOCTH HIMCHCHHS Pe3yISTATOR
B NpOLCCCE PElICHHS ABTOMATHYECKH YMCHBUIACTCA WAl W HaoG0-
por [1]. Kpome TOro, porpasa ¢ NIepeMeHHBIM LIAroM B OTIHIHE OT
HIPOTPAMMBI € TIOCTOSHHAIM IAOM BHUIOIHSET KOHTPOTh OUIHGOK MO-
CAMPOBANHS H ONPEIEIICHHE Nepeceueis HyIs.

‘Onuis Solver: 3a1aeT HecKONLKO BAPHANTOB METOZ0B MOZEIHPO-
nanns. Tepasiii napuant (diScrete) HCTOTB3yeTCH 1A pacdera Juc-
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KpeTHEIX cHCTeM. OCTATBHEE METOM! HCOTE3YIOTCR U acteTa He-
npephiBHBIX cHCTeM. TIpH MOZEIMPORANMI C MEPEMEHHBIM LIATOM 110
YMOITHAHMIO YCTAHABTHBACTCA METOX 0ftero Hasnauenns odedS (omio-
Laromsiil aBRbi MeTox Pynre — KyTTa 4-r0 i 5-r0 10pAAKOR ToHOCTH).

BuiGpats cnioco6 Mozenuposaus Variable-step. Ilpu orom cii-
CTeMOIi 110 YMOJMAHHIO YCTAHABIHBAIOTCS HAUCHHA AULO:

— U1 MAKCHMATIEHOTO LIAra PACHETA, KOTOPHIi ONPEAEIAETCS Kak

Max step size = (StopTime - StartTime)/50;

— MHHIMATBHOrO Wiara pacera Min step size;

~ HAMAILHOTO IHAYCHIA Wara Mo HpoBanNA Initial step size.

Jlns BiGpanoro Ha pucynKe 10 MANa30HA TIDH MOZETHPOBAHMH
C TepeMHHEIM IATOM MOACTHPOBANNS MAKCHMANbHI War pacuera
B cexymzax pasen (27— 0)/50 = /25 % 0,126.

5.5 HauaTs MOACTHPOBANHE ¢ IOMOIKIO KoMansi Simulation=>

Run Y. Ha picyske 11 npeiCTaB/IeHs pe3y/ITaTEl MOJCIHPOBAHIS,
HOKALIBAIOLIME TAPMOHMYECKHE CHTHATE HA BXOJE H Ha BHIXOZE AH(-
(epenuupyiomero Goka Derivative.

B Scope = C) [

CERFLLIENE] B
5
o/ \/
5
5
0
-
0 1 2 3 4 5 6
Time offset: 0

Pucysok 11
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113 rpaKoB BIINO, 4TO 15 0GOMX CHIHATOB AMILIHTYZA pasHa 5,
IePHOA CHHYCOMJAIBHOrO CHIHATA B ceKynax papen T=2mm 6,28,
4TO COOTBETCTBYET HACTOTE CHHYCOMAATEHOTO CHIHATA B TEPLAX PaB-
Holi f=1/T=1/2m) w yrIOBOH uactoTe B pAIMANAX B CeKyHIY
®=2nf = 1. Cunycouransii curnan sin(t) ua Bxoze Andiepentupy-
Jouero G710k IpeOGpA3yETCA HA €ro BIXOXE B CHIHAL COS(t), TaK Kak
Anchdpepeniiuan oT CHHyca pasei KocHRycy.

5.6 VCTaHOBHTS B ZMAIOTOBOM OKHE ‘ScOpe’ parameters: na 3a-
Knake Style Tan Mapkepa Marker: B TOHKAX AMCKDETHALIMH, HCNOTb-
3yeMOro U1 NOCTpoCHHS rpadHKa B OkHe SCOpe, B BILIE KpYTa.

Hauar, MozieupoBanie ¢ noMousIo Komaszst Simulation=>Run.
Ha prcynke 12 NpeACTABICHE! Pe3yIILTATH MOACIHPORAHHS. PACCTOS-
HiHE MEAy ABYMS COCCAHUMM MADKEPAMH COOTBETCTBYET HHTEDBATY
HCKDETH3AK, Hepe3 KOTOpiili N0y HeHNbIE JAHHbIE MOACTHPOBAHILS
HENOIB3YIOTCS U1 TOCTPOCHIS TPAHKOR.

B scope =
EREEN LIRS -

5

0 1 2 3 4 5 6
[Time offset: 0

Prcynok 12

5.7 VCTaHOBHTS B ZMAOTOBOM OKHE ‘ScOpe’ parameters: na 3a-
xnake General s ciicka Sumpling suaucine Decimation, pasisiy
&, 410 COOTBETCTBYET WIAry AMCKDETHIALMM JUIs TI0CTpOSHNS Ipad-
Ka, paHoMy ST/25 = /5 % 0,63.
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Hauars, MojieMpoBanie ¢ HoMONLbIo Kovarki Simulation=>Run.
Ha prcyike 13 NpeACTABICHE Pe3y/ISTATE MOACTHPOBANMS. PaccTos-
Hie MEALY ABYMS COCSIMHMM MADKEPAMH COOTBOTCTRYET MHTEDBATY
JHCKDETH3ALUH, TIpHMEPHO paBHOMY 0,63.

Bl Scope =8 X
20 @< i 0%%Bas -

[Time ofiset. 0

Pucynox 13

m 5.8 CMOJe/IHPOBATE CXeMy, NIPHBEJCHHYIO HA PHCYH-
Ke 9, YCTAHOBHB /U4 Hee YACTOTY KoMeGaimii (B pajuanax

B CeKYHJy) M AMITHTY 1y, PaBHEIE HOMEDY BADHAHTA.

TloR0GPATE NAPAMETPEI MOACTHPOBANHS TAKMM 0GPIIOM, HTOGH
na rpadike B Gioke Scope OTOGPAKAICA OAMH MepHOA. BiuiownTh
B OTHET 110 1AGOPATOPHOi PABOTE COTEPRMMOE PAGOUETO OKHA C MOIE-
B0 M OKHA TIAPAMETPOB BXOZIAUIIX B Hee Giokos. [IpeicTaBuTh pe-
3yILTATEL MOACTHPOBAMIIS B OG30pHOM OKHE G10Ka SCope /U1 TaveHis
ero napaverpa Decimation, passoro | 1 5. TIposecT anain nonyse-
HBIX PpAKOB 3ABHCHMOCTEI I CACTATS BHBOZLL

6 TlocTpouT GIOK-CXeMy S-MOJelH, Cofepaameil creayione
Gaoku Gubmorexn Simulink: Pulse Generator u3 paviena Sources,
wirerpupyiouuii 610k Integrator us pasena Continuous, 610k Mux
w3 pasaera Commonly Used Blocks i Scope 3 pasiena Sinks (pi-
cyHok 14).
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6.1 Bunomamts 2soiioii mensox no Groky Pulse Generator u
YCTAHOBHTS B IIOABMBILIEMCS OKHE C/ICAYIOIIE THAUCHI [1APAMETPOB:

— T mynyssco (PulSe type:) — HempepsIBHbLi UMNYIIBC, Apry-
sent pews (Time based);

— spews (Time(t):) - Use simulation time;

— ammntyza (Amplitude) - 1;

— nepuon B cexynzax (Period) - 2;

— WMpUKA WMITY Tkca B MpOLEHTAX OT nephoza (Pulse width) - 50;

— BOJMUNHA FAICPAKH EPBOTO HMIYIECA OTHOCHTENBHO {=0
(Phase delay) - 0.

6.2 Bunomunts Aoiinoii mero 1o Gaoky Integrator u ycrano-
BHTH B NOABHBILICMCS OKHE C/ICAYIOLIE THAUCHHS

— HCTOMHMK HAMATBHOTO 3HaueHHS BIXOZHOTO crmana (Initial
condition source:) — muyrpesnii (Internal);

— HaUAILHOE WaUCHHE BHXOTHOTO Curiaza (Initial condition:) - 0;

— nepxuuii yposeHs orpamiueHis Bhxomworo curuana (Upper
saturation limit) - inf (GecxoneunocTs);

— minkuuii ypoBeHs OrpaHiMeHHs BHXOZHOro curnara (Lower
saturation limit:) — ~inf (Miyc GecKOHeUHOCTE).

6.3 BUnOMMNTE ABOHHOI IUEIMOK 10 GI0KY MyJIBTHILIEKCOP (cMe-
citess) MUx, IpeAHIIHANCHHOMY /U1 OGBCAMHEHHS BXOMHBIX CHIHA-
JI0B B BEKTOP, M YCTAHORHTE B NOSBUBLICMCS OKHE CICAYIOIUHE 3Ha-
senns:

— komectao exozon (Number of Inputs:) - 2;

— cnocot oroGpaneins (Display option:) — bar (eprikatsisii
V3K IPAMOYTOIBHILK HEPHOrO BeTa).

6.4 CoMHHTS GIOKH B COOTRETCTRHI ¢ PHCYHKOM 15.

6.5 Bunomuts Asoiikoii WemMok 10 G10ky SCOpe i YCTAHOBHTE,
a irazke Style okna ‘Scope’ parameters Genuii uper (urypsi Fig-
ure color: u dona Axes color:, a user oceli — 4epHb.
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3aaath B oGnactu Line: /15 neproil mumiii THI THHIN — crTOWI-
Has, TOMHHY — 2, LUBET — YepHbL, THII Mapkepa Marker B Toukax Auc-
KpETH3ALIMH — B BiLZe KPYra.

3a2ath B 06racti Line: 11a BTOOI AMuMii THI JMHHH — NyHk-
THpHAs, ToAHY — 2, UBET — depibii, THII Mapkepa Marker B TouKax
JvCKpeTU3AH — none.

Jlis wncpopmauocT! Ha Briake General B okie ‘Scope’ pa-
rameters HEOGX0MMO YCTAHOBHTS (akok Legends.

6.6 Tlepe BHIIO/IHEHHEM MOACTHPOBANMS CHA4ATA HEOGXOXMMO
YCTAHOBHTE TpeGyeMbie NAPAMETPhI MOACTHPOBAHIS, BHGPAB KOMAHAY
Simulation=>Model Cofiguration Parameters.

3azatk & o6aactu Simulation time okia HacTpoliKH HapaMETPO!

~ IHAUEHH HANAILHOTO BPEMEHH MOJe/HpOBaHs Start time: 0.0
M KOHEHHOTO BpeMeHH MoJeaupoRanis Stop time: 10 (sexmuma Ko-
HEWHOTO BpEMeHH BHODAHA W3 YCIOBHS MPOBEICHHS MOZEIMPOBAHHS
B TCUCHHE IISTH NIEPHOOR FAPMOHHIECKOTO CHIHATA),

—mun peueins (Type:) Fixed-step (pemenite ¢ (UKCHPOBAHHEI
waro);

— MeTox Mozemposaiits (Solver:) odel (vetoa itnepa);

— amauenne pukcuposantioro wara Fixed-step size — 0.5, uro co-
otReTCTRYeT 21 TOUKE MOACTHPOBANIS.

6.7 HauaTs MOAQIHpOBANHE ¢ IOMOIKI0 KoMansi Simulation=>
Run. Ha pucyHie 16 IpeACTABICHE Pe3yIbTATH MOACTHPOBANHS. Bhi-
X0aHOli BeKTOPHAIi CHTHAT MybTHILICKCOPA MUX NIOCTYNAT Ha BXOA
Goka Scope, B pelyIbTaTe HA €0 IKpaHe CTPOSTCA ABA rpadka:
CILIOUIHAN MHUA COOTBETCTBYET BLIXOZHOMY CHIHATY Gioka Integra-
{Or, 2 NYHKTHPHAS TMHHS COOTBETCTBYeT BRIXOJHOMY CHTHATY Gl0Ka
Pulse Generator.

Hasas Ha cpeanioio kionky ¥ 1a nane;n HHCTpyMeHTOB OkHa
Scope, KOTOA: 0IBOIACT ABTOMATHYECKH YCTAHABIUBATS OITHMAh-
Hbiii MacuTaG oceii. TIpH 9TOM pe3y/IbTATH MOACAHPOBANHS NPeoGpa-
3y0TCsl K BIY, IPEACTARIICHHOMY Ha pHCyHKe 17.
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W 6.8 CMOJIeIHPOBATE CXeMy, NPHBEJCHHYIO Ha PHCYH-
ke 15, yCTAHOBHB I8 Hee AMIINTYAY U NIEPHOA TPAMO-
YTOJIBHEIX HMITYJIECOB (B COKYHAAX), PABHBIC HOMEpY Bapi-

aua.
ToA06paTh NApaMeTPsi MOXETMPOBAHHS TAKHM OGPA3OM, TGk
Ha rpadike B G10Ke Scope OTOGPAKAIOCk IATh NEPHOLOB. BRIIOUHTE
B OTET 10 NaGOpaTOPHOIi PAGOTE COTEPKMMOE PABOUErD OKHA C MOTe-
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JILIO 1 OKHA NAPAMETPOB BXOJAUINX B Hee G10KoB. [IpeiicTasuTh pe-
3yILTATE MOACTHPOBAIIS B OG30HOM OKHE G10Ka SCope /U1 TaveHis
ero napamerpa Decimation, pasioro 1. TIpoBecT QI3 MOMYHCHHEIX
IPAGHKOR 3ABHCHMOCTEIH H C/IATS BIBOSL

7 Moctpouts, Giok-cxeMy S-wojte, conepameii crenyioume
Gaoki GuGamorexn Simulink: Signal Generator 1 Constant 3 pasie-
12 Sources; G0k ycwTens Gain, 610k cymyuposanis Sum i G0k
syaTHiLIeKcopa Mux 3 paviena Commonly Used Blocks; G0k Abs
w3 paszesa Math Opetations; Gok Scope 3 paszena Sinks (picy-
Hok 18).

2 a
Constant
> ul
0000 Abs
00 Scope
Signal Gain
Generator
Pucynok 18

7.1 Bunomunrs 1eoiisoli menok o Gaoky Constant u ycrauo-
BUTE B NI0ABHBLIEMCH OKHE 3HAYCHHE NOCTOSHHOTO BHIXOIHOTO CHIHATA
(Constant value:), pasioe «2».

7.2 Bunomunts awoiisoli menok no Gaoky Signal Generator u
YCTAHOBHTS B TIOABMBILICNCA OKHE C/ICAYIOLIE THAUCHI:

~ (opya Boauki (Wave form:) — sine;

— mpens (Time(t):) - Use simulation time;

— amnTy 22 rapmoseckoro curnaza (Amplitude:) - 1;

— wactora koneSanmii (Frequency:)— 1

— eaumnua mavepenns wactors: (Units:), repu — Hertz.

7.3 Bunomunts ApoiiKoii w0k no Gioky ycwntens Gain
YCTAHOBHTS B NIOABMBILIENCS OKH 3HA4CHHE KOXDQHINMEHTA yenerits
(Gain:), pastioe «2».

7.4 3uauenns napaverpos Groka Abs, KoTophlii BHHCIST aGco-
JIOTHOE IHauCHHE BXOIHOTO CHIHANA, M 0/IOKA CYMMHPOBAHMS Sum
OCTABMTE 10 yMOIMaRHIO.

Mpusesanne ~ o ymorsanmo hopma Groka Sum B Bwze Kpyra,
CBEpXY, CTeBA M CHH3Y KOTOPOTO PACHOTIOKEHS! CYMMHDYIOUIHE BXOAHI,
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a cipasa Beixoa. Jpyrie HacTpoiiki G/10ka SUM MOXHO 3A1aTh B OKHE €r0
cBoficts. Tlapaverp List of signs (THCT CHIHATOB) OMPEACTACT KOTHUSCTEO
BXOJIOB CYMMATOPa (B 3ABHCHMOCTH OT KOHUECTBA CHMBOIOB) H HX JCHCTBHE.
TIpH 5TOM (hHKUHOHATTEHBIE HACHIS CHMBOIIOR CIAYIOILIE:

| - BXon 670ka He 3aneiicTBoBaH;

“+ — npsvoii BXOA (CHTHAT cyMMHpyeTCs);

— — uuBepCHBIi BXOA (CHTHAT BbIHTACTCS).

Tlo yMOTHAHMIO Yepe3 IPOBEN YCTAHOBIICHBI CIICAYIOIHE CHMBOTH:

4+

7.5 Bumomins 180jiH0ii ek 1o GioKky MyabTHILIEKCop Mux
H YCTAHOBHTH B NOSBHBLICMCA OKHE KOAH4CCTRO BX0X0B (Number
of inputs:), pasioe 3».

7.6 Tlepex BEINOHEHHEM PACHETA YCTAHOBHTS NAPAMETPE MOAC-
JmpoBaMs ¢ noMombi0 Komanzs Simulation=>Model Cofiguration
Parameters.

3azats B oGaact Simulation time okia HacTpoliku napaveTpo

— 3HAUEHHA HAYAILHOTO BPEMEHH MOJe/MpoBanis Start time: 0.0
H KOHEMHOIO BpEMeHH MOJeNupoBaHis Stop time: 2 (BelH4HHA Kotied-
HOTO BpeMeHH BLGPAtA H3 YCIOBHS NPOBE/IEHHS MOJETHPOBAHHS B Te-
“eHie ZIBYX MEPHOZOB FAPMOHHYECKOTO CHIHANA),

— i pemerns (Type:) Fixed-step (petenite ¢ (UKCHpOBAHHEI
warom);

— Merox Mozeposasus (Solver:) odel (veton Jiinepa);

— mauenne (pukcuposanmoro wara Fixed-step size— 0,02, uro
coornercrayer 100 ToMKaM MOACIHPORANHS.

7.7 3anycruTs mporpawMy Ha Moenuposanme. Ha pucynke 19
PEICTABNeHE! Pe3yTLTATE MOZIETHPOBaHH G10Ka Scope.

Pucynox 19
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Buixozuoli BeKTopHIii CHrHAT GloKa MyBTHILIEKCOPa MUX no-
crynaer Ha Bx0X Ga0ka Scope. B esyJIsTATE Ha €ro JKpaue B OLHIX.
0CSX CTPOATCS TPH rpadka:

— ITPHX-TIYHKTUPHAS JHHHS COOTBETCTRYET BEXOAHOMY CHIHALY
G0Kka cymMpOBaHIts Sum, pasomy 1sin(2w1.4) +2;

— NYHKTHDHAS HHIS COOTBETCTBYET BHIXOZHOMY CHIHATY GAOKA
Abs, pasnony [1sin(2m 1),

— CILIOWNAZ JMHHS COOTBETCTRYET BHIXOZHOMY CHIHATY GA0KA
yenurens Gain (ko>pHLHEHT yCHIeHUS KOTOPOrO pasei «2»), pas-
oy 2sin(2-w1-0).

w 7.8 CMOJeNHPOBATE CXeMy, NIPHBECHHYIO HA PHCYH-
Ke 18, yCTaHOBMB JU1s Hee 4aCTOTY KoeGanuii (B repuax) u
AMILINTYly TADMOHIYECKOTO CHIHATA, PABHBIE HOMEPY Bi-
puaiTa,
TloA0GpaTh NAPAMETPE MOXEIMPOBANHS TAKHM OGPA3OM, HTOGH
na rpaduke B Gloke Scope OTOpAKAIOCk ABA NEPHOA. BKIOWHT B
oter 10 naGopatoproli paGoTe CoepIKMMOE PAGOHEro OKH ¢ MOAREIO
H OKHA IAPAMETPOB BXOJAIMX B Hee G10K0B. [Ipe/iCTABHTE pesy/bTaTsl
MOCTHPOBANIIS B 0GI0PHOM OKH (/10Ka SCOpe I 3HACHHS €O Na-
paverpa Decimation, pastioro 1. TIpoBecti auamis nony4eHHHIX rpa-
(DHKOB 3aBHCHMOCTEI I CAENaTS BLIBOLL

8 OsmakosuThes ¢ pavienom GuGanorexs SimPowerSystems
(prcysok 20), KOTOpas IPEACTABIAET COGOIi HAGOP BU3YATSHEIX 0OBEK-
TOB, U1 MMHTAIVOHHOTO MOZETMPOBAHIS THIOBEIX >ICKTPOTEXHINC-
CKIX yCTpOIiCTB (YCTPOCTB CIUIOROIi ICKTPOIHEPIETHRH, TAKUX Kk
IEKTPIYECKIe ABHIATEIIN, TCHEPATOH, TPaHC(OPMATOPSI, MpeoGpaso-
BATEIH, A TAKIKE TMHUH SICKTPOIEPEat, dIEMEHTH CIUIOBO HIEKTpO-
ikt 1 7.2 TIDH STOM HMEETCS BOIMOKHOCTS COYCTATE B OZHOI MOZe-
1 KaK MMHTAILOHHBIE, TAK I CTPYKTYDHBIE GIOKH.

Daementsi w3 paszena Electrical Sources Gubmorexn SimPow-
erSystems (pucyno 21) BKIIOSAOT B Ce0fl PAVIHAMbIC HCTOMHMKI
SHEpIiM, TAKHE KAK:

~DC Voltage Source n AC Voltage Source - mieansusiii ne-
TOMHUK TIOCTOARHORO H IIEPEMEHHOTO HATSACHHS;

~AC Current Source- Wieatbbili HCTOYHHK NEPEMEHHOIO
‘ToKa;

— 3 Phase Source — Tpexdasibiii HCTONHUK HANSAKCHIS;
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—oneventsl w3 paszena Elements GuGinorexn SimPowerSys-
tems (prcynok 22), BKIIONAIONIE B Ce0s PAMINHEIC HICKTPOTEXHIMC-
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— 6aoku Series RLC Branch u Parallel RLC Branch - nocieso-
Batensuas u napamiensuas RLC wemb, napaveTpsi kotopoii sanaiotes
4epe3 CONpOTHRIICHHE B OMX, HHIYKTHBHOCTS B FeHDI  @MKOCTS B (ha-
paax;

— Gaoku Series RLC Load i Parallel RLC Load - nocaetosa-
Tenbhas u napaenshas RLC Harpyska, napamerpsi KoTopoii sanaiotes
4ePe3 MOLHOCTE LeH NPH HOMMHATSHOM HATIDIKCHIH H HACTOTE.

Kpome T0ro, B GMGNHOTEKY BXOIT aHaTOTHuHBC TpeX(asibie
VIEMEHTH, 4 TAKKE BIUMMHBC MHIYKTHBHOCTH, DAVIHSHbIC JHHHN
MIeKTpOnepeat W TPaHCHOPMATOPEY, 3aserUICHHE, HEHTPATS 1 T.1.

OGparie BHMatKe, 4T0 MoAenH B SimPowerSystems (P-yoze-
N C P-BXOZGMH M P-BHIXOJAMH) HMHTHPYIOT HPOCCCH B OICKTDH-
MECKHX IISX H NOIBOIIOT BHIIOTHATS MOJETHPOBANHE HA NPHHLIH-
muanhoM yposse. OHH OTAUAIOTCA OT S-wojencii (¢ m-BxoZamu
H ¢ m-BbIXOZAMH) 13 APYTUX GubamoTek Simulink, B KOTOpEIX BXOZHAE
H BHIXOHEIC BEIMAHHA HE HMEIOT (IIIECKOrO COACPAANHS, A JHHHN
coeaenNs nepeHoCAT HekoTopiii mabopMaNHORHSIi curnan. C mo-
MOIILIO S-610KOB COVIAIOTCA MOZIEH Ha (hYHKIHOHATLHOM YpOBHE.

Tostomy P-GIOKH HE MOTYT HENOCPACTBCHHO MOKIIOMATHCS
K S-Gnokam. JUis casan P-010koB ¢ S-G/I0KAMH HCNOAK3YIOTCA ALK,
otaensHsie Groku GuGmoTexn SimPowerSystems:

— & payene Measurements (pucyHok 23) PaTMELIAIOTCH GIOKH-
HIMEPHTEIH, UMEIOUHE P-BXOZHI 1 M-BHIXOAN! (aMnepyerphi Current
Measurement, sorsTetpt Voltage Measurement u 1..1.). i G10kn
HMEIOT P-BXOAB U1 HOAKIIOHCHHs HIMEPHTEIIs K 2IeKTPHIECKOli LerH,
2 Takke 110 0ZHOMY M-BbIX01Y (B G710Ke aMIIEpMETPA OH 0G03HAeH (b,
2B GI0KE BOIBTMETPA — «V»);

— & pasene Electrical Sources pasmeimaiorcs GIOKH HCTOMHMKOR
NEKTPHYECKIX CHIHATOB, UMEIOUIHE M-BXOJIS! 1 P-BIXOTbY/BXO/.

Jlpyrie GiokH, npeaHasHAeHHEIE /U1 NPeOGpalOBANIS, B AAHKON
paGore He HenoayloTes.

Kpowe Toro, u1s paGors SimPowerSystems-MoeiH He0GX0M
Grok  Powergui, KoTopeii pasMemaercx B pasaene GMOMMOTEKH
SimPowerSystems (cy. picynox 20). biok Powergui nosemaeres
B MOZEIb B 0GOS MECTO U HE TIOAKMIONACTCA K APYTHM TIEMEHTaM,
OH N03BOIAET 3A1ATH HAYTLHEIC SHACHHS [ICPEMEHHBIX MOJCIH, BHI-
HOJHHTE PACHET YCTAHOBHBLICTOCA PEAMMA, OCYLICCTBTE WHHLMAAIH-
A0 CXeMBI, CoXepAaILeli YEKTPHYECKHE MALIMHEL, HANTH NoIHOS
CONpOTHBIICHIE (MMIEIANC) e 1 T.1.
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Pucynok 23

8.1 Cosnate Mozents ookowTypuoii RLC-uemu (pucysok 24)
¢ HCTOUHHKOM CHHYCOWTLHOTO Hanpskenis AC Voltage Source.

Current Measurement

o v Scope
1 Votage Measurement !
! 100 Om
5sn(3144 B

100 Mk

Continuous
30 Mo

T powergui
Prcynok 24

B xauectne RLC-tienu ucnonsaosars 6ok Series RLC Branch,
npexcTapnsionMii OGOl 110CEN0BATENLHOE COSIMHEHHE CONPOTHBIIE-
i, MHYKTUBHOCTH H @MKOCTH, KOTOPBIM MOAKHO 31aTh JIOGHIE, B TOM
uHCIe HyleBbic M GCCKOHEHHO GOTBIIME, JHA4CHHS NAPAMETPOB (CHC-
TeMHas KOHCTAHTa inf). OTPEAAKTHpYiITe 0GOIHANCHHS YICMEHTOR Ha
CXeMe B COOTBOTCTBMH C piCyHkoM 24, BMNOTHHB menok JIKM
10 TKCTOBOIf HAMHCH DCMEHTA.
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3azate a1 Guokos AC Voltage Source u Series RLC Branch
IMAYCHHS N1APAMETPOB, YKAIAHHAIE B COOTROTCTRYIOIIEM OKHE IapAMET-
pos (prcymkn 25-26).

[ s P Ao o e
AC Voltage Source (mask) (link) e
Ideal sinusoidal AC Voltage source.

Parameters
Peak amplitude (V):
5 |
Phase (deg): =
0

Frequency (Hz):

50

Sample time:
0

Measurements [None & |-
[ o ][

Cancel || Help ][ Apply

Prcynox 25

JUis nonydenus rpadMKOB 3ABHCHMOCTH TOKa B STOfi wem
H BXOJIHOTO HATIPAKEHNS, A TAKIKE JUTA HIMEPEHHA CIBHTA 110 hase Mex-
1y BXOZHBIM HAIIDSACHHEM H TOKOM, HCTIOTK3yeM ABYXKAHATbHBL G10K
Scope, Ha BXOZ! KOTOPOTO MOZAIOTCA CHIHAT ¢ M-BHIXO/IOB aMIIep-
MeTpa i BozbTverpa: G0k Current Measurement i Voltage Measu-
rement COOTBETCTBEHHO.

8.2 VCTaHOBHTS TpeGyeMbie IAPAMETPH MOZETHPOBAHIA € TOMO-
ko komaner Simulation=>Model Cofiguration Parameters=>Solve.
3azath B oGnacti Simulation time 3HaUCHIA HANVILHONO BPEMEHH MO-
eanposanis (Start time:), pasHoe «0» i KOHEUHOrO BPEMEHH MOZEIH-
posanus (Stop time:), pasaoe «0.02». BuGpars B oGractu Solv-
er options (Ilapavetpsi pacuera) pasHoMepHBIli War AHCKpETH3ALIN
Fixed step u Tun rpauka Mozemupyemoro npouecca odel (Euler).




image25.png
3azats B oGnact Fixed step size 3uaucHie wara JUCKpETH3AH pan-
Hei 00001, 1T0 cooTaeTCTBYeT BEIGOPY 200 TONEK AMCKPETHIALILH.

[P Block Prameters: 100 Ow 100 win 30 we® K L]
Series RLC Branch (mask) (link) z

Implements a serles branch of RLC elements.
| Use the 'Branch type parameter to add or remove elements from the branch.

Parameters

Branch type: [RLC -

Resistance (Ohms):
100

Inductance (H):
I o1

Set the initial inductor current
Capacitance (F):
3006

|

|| 1 Set the initial capacitor voltage

o | (o] i
Pucynok 26

8.3 HauaTs MOACAHPOBANHE ¢ NOMOISIO Komanxsi Run, a 3arem
BRI WETKHYTH HA WoOpaKeHiM Gloka Scope. B pesyisTare Ha
KpAHE NOABHTCS HOBOS OKHO SCOPE C HIOGPAKEHHIMH TPAQHKOB M-
MEHEHHS! BO BPEMEHH TOKA 1 HANIDAACHIS.

VeTaHoBHTE OMTHMATBHBL MaCITA Oceli B oKkHe Scope i mpo-
‘AHAIIMPOBATE IOTY4EHHOE B HeM H30BpaKeHHe (pHCyHOK 27).

M3 BepXHEro rpagika BHINO, 4TO AMILIHTYAHOE IHAYCHHE TOKA
B e npuepHo pasio 40 MA. H3 HitKHEro rpagika BUAHO, 4TO av-
IIHTY MO 3HA4CHHE BXOAHOrO HANPSACHHS B LIH PasHo 5 B.

CatBir o e MeAZY HANPAKCHHEM 1 TOKOM PABCH NPHMEDHO
35° ¢ MHHYCOM, HTO COOTRETCTBYT PEIHCTHBHO-EMKOCTHOMY XAPAKTEPY
conpoTHRICHHS e,
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Pucynox 27
Omeem 8.4 ChOzCMpPOBATS CXeMY, HPUBCACHHYIO Ha PHCYH-

Ke 24, YCTAHORHB B Heli JMAUCHIS AMIINTYS! H 4ACTOTHI
KoneGaHuil (B repuax) A MCTOMHHKA CHHYCOMIAILHOIO
HANPAKEHHS, PABHEIC HOMEPY BAPHAHTA.

Tox06paTh NApaMeTPsi MOXEIMPOBAHHS TAKHM OGPA3OM, TGk

Ha rpaduke B G710ke Scope OTOGPAAICA OAMH NIEPHOA KoneGaHii rap-

MOHIteCKOr0 CHrHANA. BRIIOWHTS B OTHeT 10 iaGopatopoii paGore

CojtepKinnOe PAGOtEro OKHA C MOJEIEIO H OKHA [IaPAMETPOB BXOJALIX

B Hee G10kon. TIPEACTABHTS PE3YISTATH MOACTHPOBAHIS B OG3OPHOM

oxne Goka Scope Ui suaenus ero napaverpa Decimation, pasio-

ro 1. TIpOBECTH AHAT3 NOAYdeHHBIX TPAQHKOB 3ABHCHMOCTEli  Cle-
naTh BHBOMEL

8.5 CMOZeIMPOBATE CXeMY, IPHBEACHHYIO HA PHCYH-
Ke 28, YCTAHOBMB B Heli IHAYCHHS AMILIATYS! U 4ACTOTHI
KozteGanuii (B repiiax), PABHAIC HOMEpY BAPHANTA.

Toz0GPATE NAPAMETP! MOACTHPOBAHILS TAKIM 0GPAION, HTOGH!
Ha rpagukax b G10ke Seope OTOGPAAICA OMH NEPHOAA KoeGaHii.

Buok Fourier naxoxutcs s pasaere Control and Measurements
Library=>Measurements GuOmorexn  SimPowerSystems  (picy-
HOK 29).
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SimPowerSystems. o —
Application Libraries ‘i L Fourier
4 Control and Measurements Library
Additional Components = \~t Fundamental
Filters - (PLL-Driven)
Lo
@_ 3 Mean
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Pulse & Signal Generators .| b Mean (Phasor)

Transformations

Pucynok 29

3a2aTh B okne croiicTa Gaoka Fourier Imatenie 4acToT! Kofe-
Ganuit 8 repuax (Fundamental frequency (Hz):), pasiioe Homepy Ba-
piasTa, i Homep rapmoniki (Harmonic n (0=DC, 1=fundamental):),
pasisii «1».

3a2ath B okue caojicra Gaokon Display  Displayl jopwar ski-
Boa «shorty.

BinounTe B oTeT N0 1aGopaTOpHOli paGote coxepIMOe pago-
4ero OKHA € MOZEIBIO H PE3y.ISTATAMI MOACTHPOBAHHS Ha IKpaKe G0~
xon Display u Displayl, okia N3paMeTpOR BXOASILX B MOZelh G0~
KoB, a Taioke 0630pHOE OKHO Gloka Scope. TIpoBeAITE anaH3 No1y-
ueHHOro rpaQMka 3aBHCHMOCTH W noKaiaumii Giokom Display
Display1. Crenaiire BhiBos!.
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KOHTpO/IbHble BONPOCH!

1. Uro Taxoe Simulink Library Browser?

2. Kakiny 0Gpasom CTPOSTCs G10K-CXeMbI B IPOTPAMMHOM MOZY-
e Simulink?

3. Kak B Moaens 206asiTs HOBK 6:10k? Kak ckonuposats 610k
B OKHe MozenH?

4. Kak coeamuuTs G10KH MexAy CoG0i?

5. Kak cAeaaTh, 4TOGH OZMH W TOT @ CHTHA NOCTYIAT Ha He-
CKoIBKO G10KOB?

6. Kak yzairs 610K 1w casish ety Gaokamn?

7. Kakity 0Gpa30M MOAKHO H0BOPA4HBATE G0KH?

8. Kakie HacTpoiiki HMeiOTCs y 0530pHOTO okia Seope i G0Kka,
Display?

9. Kakie nactpolikn myeiotcs y G10kon-ctoummkos Constant,
Sine Wave, Signal Generator u Pulse Generator?

10. Jlns sero npeamasuasensi Gaoku Integrator, Derivative,
Gain, Sum, Abs 1 Mux?

1. Kaxue macrpoiiku HeoGxommno sazars 5 okue Cofigura-
tion Parameters nepet 3anyckom Moenu?

12. M3 Kakix cooGpakentii BHIGHPACTCA BEMS MOACTHPOBANHS?

13. Kak BHGHpACTCA 3HAMCHME WIArA NPH BHGOPE MOZEIMPOBA-
iR ¢ QHKCHPOBAHHBIM MIaroM?

14, UeMy paBHO MAKCHMATHOE 3HAYHHE LATa IPH BHGOPE Mo-
CAMPOBANHS C NEEMEHHBIM LIAroA?

15. Uem ommuaiorcs P-wonemn w3 pasiena SimPowerSystems
or oBkmHkIx S-voeneii Simulink # kakiy 0GpazOM ocymecTAIsETCA
Cca MeKAY HitnH?

16. Kax mactpanaiorcs napamerpsi Gaokos Series RLC Branch
1 AC Voltage Source i kakie 3Ha4eHls OHH MOTYT IPHHUMATE?

17, JLas wero npeamasuasens: G1oki i3 pasiena Measurements?
. Kakoso nasuaueine Gioka Powergui?

19. Kakie nactpoiii iveiotes y Gaoka Fourier?
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MeTopauuecKue ykasaHus

Jlns anamia paGoThI CAOKHAIX cHCTeM (OGHEKTOR) IMPOKO MIpH-
MEHSIOTCS X CTPYKTYPHBIC CXCMB, B KOTOPHIX OHH NPEACTARICHE!
B BitZe G10KOB (3BCHBECR) C ONPEAC/ICHHBIMH XADAKTEPHCTHKAMH.

CIPYKTYpHbC CXEMBI IMHIiHBIX CHCTEM COCTOST 3 THIIOBHIX
3BeibeB, B COCTAB KOTOPHIX MOTYT BXONHTE aIlepHOJMUecKie, KoneGa-
TelbHEE, YCHIHTETbHb, HHTErpHpYIOLUe, Anddepentpyloe 1
Apyrie meHbs.

B ofluem ciiyuae 3neHy COOTBETCTBYET MepEAATOMHAS (ByHKILS
Bita:

W(s)=Y(s)/X(s),

e X(s), ¥(s) - m30Gpakeiue COOTBETCTREHHO BXOAHOTO H BHXOIHO-
r0 cHranos.

B TaGmite | NpHBE/IeHE! MepEaATOMHEE (YHKLMH OCHOBHEIX B~
JIOB 3BEHBEB.
TaGmuua | - Tlepeaarounsie (ynKi 3nenses

Hauvierosasue 3pera Tepenatounas dyskums

| Anepuomucckoc sseHo nepsoro nopaa

KoncGateHoe 38cHO BT0pOro Hopaka

e ———— o~ P S

aseramesn ‘nepedamounoit rynkayuu dorrns TiTs? +Tas +1
s oumaexcubiz)

|V cinmrensioe (IporopuoRaTbHoe) sBeHo W5)=K

lupdepenmpyroniee sseno W(s)=Ts
irerprpytouice saciio W)=

Ts

B TaBlIMIte HCTIOMB3YIOTCS CCAYIOIIME 0GOIHANCHHS:
T - HOCTOSHHAs BpeMeHi;
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K = koodpHuMeRT yeiuienist (IPOOPUHOATEHOCTH);

s = oneparop.

B s1aGopatopHoii paGoTe paceMaTpHBACTCS CHCTEMA yIpaBICHIS
OGBEKTOM 110 YrIly er0 1I0BopoTa . CTPYKTYPHAS CXEMA CHCTEMBI IIpH-

Beteta Ha pucyke 1.

Breunee BosaeiicTaune
¢y
Cysmmarop Perynsrop  Tpusox O6bext
®
o |z R(s) | PGs) B(s)

Hswepirensias cucrema

H(s) |«

Prcyno 1

B COCTaB CHCTEMBI BXOAT: OPraH ypaBICHILA, KOTOPLIM J1aeTcs
HeOBXOAMMEIi Yrol MOBOPOTA OGBEKTa (P(), PeryIATOp, NPUBOA, 05b-
KT YNpABIEHHA, UIMEPHTELHAR CHOTEMa, 1BA CYMMATOPA 1 GIOK, 3~
Aot BHemtee BosCiicTBUE O .

JlBikenue OGLEKTA OMHCHBACTCH MMHEHHON MATEMATHYECKON Mo~
@10 BTOPOFO NIOPAAKA B BIAE CACAYIOUIEi TIepeaTouHOf hyHKL:

Bo=—5
S(Tgs+1)
e Ty — nocToAHHas BpemeHn oBhekta; K — noctosnmbiii kospu-
e,

TIpHBOA OGBEKTa MOACTHPYETCH Kak HHTETPHpYIOUICe 3BEHO,
OXBaEHHOE IMHNNHOI OTPHIATETbHOI OGPATHOI CBAILIO, TaK HTO €ro
nepesaTouHas GyHKIHS HMEeT BHIL:

1
Tps+1’

P(s)=

1€ T — N0CTORHHAS BPEMEHH NPHBOA.

JUis wsMepeHns yria MOBOPOTA OGHEKTA HCMONBIYETC HIMEPH-
TelbMAA CHCTEM, MATEMATHHECKMS MOJEIh KOTOpOWi JaHCHBACTCA
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B BUAC ANEPHOIMNECKOTO 3BGHA NIEPROTO NOPAAKA C NEPEAATOMHOI
ynuneit

1
Tys+1"

H(s)=

1te Ty — NOCTORHHAS BPEMEHH HIMEPHTEILHOI CHCTeMEL.

PeryISTOp! IPUMEHSIOTCS U (POPMMPOBAHIS YIPARIAIOLETO
CHIHATA C NEBIO NIONYHEHHS HEOOXOAMMOI TOMHOCTH yNpABICHHS W
KAYECTBA TIEPEXOHOTO MpoLecea.

TponopunonasHo-uHrerpo-mpepentmpyionuii (A1) pery-
1TOP POPMHPYET CHIHA, ABIIOUIMIICH CYMMONi TPEX ClIaraeMEIX, rlep-
BOE I3 KOTOPBIX IPONIOPUHOHAITHO PABHOCTH BXOIHOTO CHIHAIA 1 CHI-
Hata OGPATHOI CBA3 (CHIHAJ PACCOIIACORANIS), BTOPOE — MHTCTpAI
CHIHAIA PACCOTIACORANHS, TPEThe — IPONIBOAHAS CHIHAIA PACCOIIACO-
sanns. ECIU KaKie-T0 W3 COCTABIAIONIIX He HOIOTb3YIOTCA, TO Peryiis-
TOP HASLIBAIOT NPONOPLMOHATsHO-HHTerpHpyiouny (TTH), nponopio-
natHo-auibepenumpyiouiny (IJ1), nponopuonamsiy (1) 1 T.1.

ECIM OGBEKT He MeHSeT CTPYKTYDY  CBOH NAPAMETPE, TO CHCTe-
Mkt ¢ TTH/I-peryIiaTopani oBeclieauBaIoT HEOOXOMMOE  KAMECTRO pe-
IyIMpOBAHIA TPH GOBIIX BHELINAX BOIMYLIAIONUX BOVIHCTBHAX 1t
novexax.

B paore HeceAyloTes CHCTeMS! yripaneris obbextom ¢ T1-
TTH/I-peryasropass.

TTH]I-peryasTop B 0GiuieM Ciyuae HMeeT nepeaaTodHyio kIO

R(s)= l(p[l L Tus}
Tys
e Kp = Kodpuument nponopusonasuocTy; T; — NOCTORHHAR HHTE-
rpuposanus; T;, — noctosmHas AnddepeHuupoanns.
B ciysae Ke HpUMEHEHHA PHILTPA MepeaTOuHA YHKIIA pasha,

L Tps
R(s)=Kp[ 14—+ R
© P[ s Tp:+l]

tae Ty — noctosumas puistpa (T = Tp /n, UpU STOM, KaK npaBILIO,
, ..., 20).
JUia cHCTeMs! ynpamiienis 0GBeKTOM, HecTeayeMoli B 1aGoparop-
Hoii paGote, 3a1aHbI CIEYIOLIHE APAMETPI:

~ yron nosopora oGexra 9= 10°
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- yron BHemHero BoseiicTBHA Qp = 2%

~ napaverpei o6texta T = 12 ¢, K = 0,06;

napaverpei npusoza Tp =3 ¢;

1apaMETPbI IIMEPHTEBHOI CCTeMkt Ty = 5 ¢;

napaverpui peryzstopa Kp = 05, Ty = 100¢, Tp = l¢, Tr =

TIph 5TOM AQHHAS CHCTEM HCCIIEAYTCA B 3 pesiy
— Ge3 pHewmmero Bo3elicTais ¢ uenonsIosanmem IJ1-perysTopa;
— ¢ BHewIIM BO3ETiCTBHEM C HCnOAB30BaNMeM TT]T-perysTopa;
— ¢ BHewmiM Bo3elicTaieM ¢ Heonb3oBatmem THI-perysopa.

Pa6ouee saganue

1 3anyerurs Matlab u Simulink.

2 HaCTpOWTS, M3 JMPEKTODHI JUIH XpAHEHUS COYIABACNBIX
1108 (komanza: Home=>Set Path=>Add Folder"), yka3as coio nanky na
Jwcke Hz.

3 Covtarh HOBYIO MOZENh C NOMOLISIO BEPXHETO MEHIO OKHA
Simulink Library Browser (komasza: File=>New=>Model).

4 JloGauTs B okHO Mozen Giok Transfer Fen (nepesatounas
yskuns) w3 rpynns: Continuous GnGamorexn Simulink, npeaasia-
“eHHOIi /UIA NONYeHH (YHKUMOHAILHEX G/IOK-CXEM DABIMIHBIX
yerpoiicts.

TomecTHTS G0K B OKHE B COOTBETCTBIM €O CTPYKTYPHOIi CXeMoli
MOZeNHpYeMOii CHCTeMS, IpHBEeHHOI Ha pHCyHKe 1.

53azats Guoky Transfer Fen nasmanie OBheKT (¢ NOMOUIO
JIKM na uneni Goka).

6 Bunomis, ABoiioii uensox JIKM Ha Giioke OGbeKT u 3azath
B NOSBMBLIEMCA OKHE NAPAMETPOB KOO(MIMEHTH NeperaTouHoli
ynxun

006 _ 006
s(12s+1) 1257 +s

Kosppuumentsi wmcantens (Numerator coefficients: [0.06]) u
mavenatens (Denominator coefficients: [12 1 0]) nepeaarousoii
(yHKIMH BBOASTCH B KBAXDATHEIX CKOOKAX 4epe3 IpoGesl B MOpAAKe
YMeHBILICHIS! CTENIeHH OIIEpATOa .

B(s

'Mi-sa ommeumii B Bepeusx mporpavaoro obecnevcrms Matlab u
Simulink HATBass KOMANI, YKIAHHBIX B OMHCAHIH K PAGOTE, W KOMGHA IpO-
PAMMB! MOTYT HACTHYHO OTIHUATECS.
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7 Anazornuso j10GasuTs eme Asa Gioka una Transfer Fen,
nasosute ux cootsercraento Mpusox i MsmepuTenbuas cucrema i
BBENTE HX IAPAMETPEL.
Tepenatountie GyHKUMH NPUBONA W WIMEDHTENHON CHOTEMI
HMEIOT COOTBTCTREHHO BIHI:
1
35+l

no>toMy aderme kodduienta uncnutens Gioka Tpuox Gyrer
pasno [1], a koddduumentos 3uamenatens — [3 1]; snauenue kodpdu-
LenTa wcaNTens Gl0ka HaMepuTenHas cucrema Gyzer pasno [1], a
Koa(puntmentos snamenatens — 5 1].

8 PasaepiyTh 610k M3MEPHTEALHASI CHETEMA B DYTYIO CTODORY.

9 JloGans u3 rpynsi Continuous Giox PID Controller (ITHJL-
peryzsop). Buauane B kauectae perynsropa memomsayercs I11-pery-
JIS10p, TI0ITOMY B OKHE MApAMETPOR HykHO BGpars Controller: PD
(prcyHok 2).

P(s)=

D H(Gs

Tssel’

vt E © < = “

Wan | PID Adarced | oota Tpes | sam tvte

[ —

Procotons @) [05 & Compersate frmia

[ (

it coafcent 9 10 pl1D.

[E=m|

1
s

Prcynok 2
Veranosnts Form: Ideal i B COOTROTCTBIN ¢ BILIOM peazye-
Moii niepeatounoli (yukumu (Compensator formula) 3azars napa-
Metpit peryasopa P, D, N:
P=Kp
D

UTr=10.
10 Mepenectn massauns Grokon cumsy saepx (wannmre TTKM
na Goke 1 BemoHMTe Komaity Rotate&Flip=>Flip Block Name).
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11 JloGasiTs B o0 Mogen G210k Sum w3 rpynms: Math Opera-
{ionS 1 YCTAHOBHTE €0 CIICB OT PeryATOpa. YCTAHOBHTE A1 HITKHETO
BX0Za CYMMATOPA 3HAK MiHYC (i OTPHIATENEHOI 0GpaTHOI CBsIH).
Jlis 510r0 B OkHe mapaverpos Giioka B nose List of signs maecti
 KIABUATYPBI epe3 npobex cHMBoLL: | +— (HesaeiicTroRaRHEI BXO,
BXOJL (LTHOCY, BXOA «MHHYO).

12 JloGasHT eime 0 610k SUM i YCTAHOBITE €r0 MEAKAY MPH-
BOOM H 0GBexTOM. HACTPONTE PACTIONOACHHE BXOIOB H BHXOIA TAK,
“TOGH epsili BXOX Gsu B BepxHeli HaCTH Kpyra (BBexuTe + + | B MOME
List of signs).

13 JloGasuTe B okHO Mozenn Giok Step w3 rpymmsi Sources
H yeTaHoBHTe ero ciesa OT cymmaropa. Hassats ero Opram ynpas-
nenns.

B oKiie NapaMeTpoB (/10KA YCTAHORHTE BpeMA NOZA4M CHIHATA
(0 B noze Step time) 1 BeNUUMHY CHTHATA — YIIA IOBOPOTA O0BEKTA
©0 (10 & noze Final value).

14 Cronmposars ok Opranm ynpaBienwsi, Neperamyis ero
TIKM. [lats evy uaseane Buemmee Boxelictaue. VCTaOBMTS uis
HETO BENINHIY CHIHATA BHEIHETO BO3CHCTBHA Q) =

15 Coeammis Bce GAOKI MOACIH B COOTBETCTBIH C PHCYHKOM
JloGasuTs B OKHO MO ABA 10Ka Seope (ocwiorpad) H3 rpymILI
Sinks 1 yCTaHOBHTS 11X B npasoli wacT nozs. Hasats nx Vnpanienue
o6hekTom 1 TloBOpOT 0GneKTA.

16 Tlogats Ha nepaaiii G710k Scope CHII C BHIXOA2 BTOPOTO CyM-
Matopa (exozuoii curnan Gioka OGBeKT), a Ha BTOPOii G110k Scope —
‘BbIXOMOl CHrHAT G0k OFbeKT (PHCYHOK 3).

N
Srwume srparonn
soveicran  Poyomop e otreropvarron
oo o] oo |,
3s+1 128%+s
S i
yrpasnesin Vawepirensran obserra
erous
i
le
o

Pucyrok 3
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17 VMEHBLINTE OKHO A0 MHHHMATSHOTO PAIMEPA, MDH KOTOPOM
GYAYT BIHBL BCE DIEMEHTHL, i CKOIMPORATE MOJCIS B Gy(bep OGMeHa
(Edit=>Copy Current View to Clipboard=>Metafile).

Berasste B oTder no raGopatopHoii paGore noxy-
T
‘CTeMEI yNpAR/ICHHS 0GBEKTOM (CM. PHEYHOK 3).

18 Veranosuts  mpems Mozenupopanus 300 ¢ (Simulation=>
Model Configuration Parameters; Start time: 0, Stop time: 300).

B oGnactn Solver muGepire BapHaTHBHBIi WAr JHCKPETHIAIM
Variable-step.

19 BumonuuTs MozeTHpOBANKE, /U4 Hero HaxaTh KHomKy Run
wa nanen ¥ 1w BGPaTH Komanzy Simulation=>Run).

20 Ha pucyiKax 4, 5 pHBe/leHb! Pe3yILTATH MOJEHPOBAHI, KO-
TOHie MOAHO YBILICTE, OTKDHIE OKHa 610K0B Scope.

[—

FLIETR 7]

0 B0 100 150 200 250 800
|ime ot 0

Prcynok 4
JUIs OO0 OTOGPAKEHHS KPHBBIX YCTAHOBHTE ONTHMATsHEL
MaciTaG no ocsm B okHax 610koB (kHomka Mexio [£ 3] Autoscale).
Coxpannts Tekyuie Hactpoiiku (konka mewio iy Save cur-
rent axes settings).
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B nosopor obvexra =8 X

2

0

0 50 100 1650 200 250 300
Time ofiset: 0

Pucynox 5

Tpumeuanue — B cyuae, eciH yCTAHOBICHHOE BPEMS MOJICTHPO-
BaHIA HEAOCTATONHO, HTOGH MIEPEXOMHBI MPOUECC NOTHOCTSO OTOBpALICA
Ha TPAGUKAX, WK OO CTHIIKOM GOTHIIOE, TO HEOGXOMHMO YCTAHOBHTS HO-
BOE BPCM H TIORTOPHTS POLICCC MOACTHPOBAHIA.

13 rpadmka BINO, 4TO NPH OTCYTCTRHH BHEIIHETO BOIACHCTBIS
npiMepHO depe3 150 ¢ 0GkeKT NOBeHETCA Ha 3axaHHbL yro B 10°,

21 Tlepenectn_pesy/lsTaTsi MOZCTHpOBAHKA C OGOMX GrIOKOB
Scope B padouyio o6uacts Matlab B Bite Matpuit (Array), B KOTOpBIX
nepbili CTonGew — BpeMs, a BTOPOJi — CHIHA (YTo 0BOPOTa).

JUis 5TOr0 Ha OTKpHITOIi MaHenM G10Ka SCOPE HAKMUTE KHONKY
{G) Parameters u suiepirre ncnaxy History. flunee yeraosirre:

I Limit data points
[V Save datato workspace

Variable name: Uprav (15 610k «Ynpanieniie 00sexToN) it
Povorot (uis Goka «Tlosopor ofnekTa»), Format: Array (coxparie-
HUE JQHHBIX B BIIE MATDHILSY).

22 Coxpanms nonysenyio Mofens B csoeii manke (Komamia
File=>Save, iy daitza LabRab2, pacumpere paiina .slx).
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23 Tepeiiri & komanwoe oo Matlab 1 co31aTh HOBOE OKHO 15
IPaHKa, B KOTOPOM GYAYT 1I0CTpOCHS! ABC KPHBIE Ha PABHBIX OCAX.

Command Window
fx >> figure(1);

24 PasGiTh OKHO WA JBE 4ACTH 110 BEPTHKANH H CACTATH AKTHE-

eI nepasili rpa.
fi >> subplot(2,1,1) ;

TMeproe 4ncio B Komaize subplot 03HA%AET KOMHYECTRO Aeek
¢ IPAQHKAMH 110 BEPTHKAIH, BTOPOE — 110 TOPHIOKTAIH, TPEThE — HOMEP.
sueiiki, KOTOPYIO KO CACIATS AKTHEHOIL

TMpuseuanne — Mpi BROAE 1O/ 1 CICAYIOMIX KOMAHA OKHO
© rpajikom He nosmACTCA Ha Kpane. UTOGH YRIACT HIMCHCHIS, HAZO
BPYUHYIO CAENATh €r0 AKTHBHBIM, UIEKHYB MBIIIBIO Ha COOTBETCTBYHOUICH
KHOMKE B nanea 3a3a.

25 TIOCTPOHTE rpaK CHIHAT YIPABIICHHS 00BEKTOM.

Command Window

> plot (Uprav(:,1), Uprav

20

B xomanze plot CHI%AIA YKATMIBAIOT MACCHB AGCINCC, 3TeM —
MACCHB OP/IHAT; JIBOCTOMHE 03HAYAET, HTO HCTIONL3YIOTCA BCE CTPOKH.
26 BaecTu 3aro1080K rpaika.

Command Window
fx >> title('Upravlenie');

27 Baectu nassanis oceii KoopuHaT.

>> xlabel('Time, s');

ylabel('\phi, deg.");

S

Mpuseuanne — BHyTpn anocTpohos A% BBOM TPEHECKNX GyKs.
paspemaerc neron3oBath Koman st LaTeX. Hanpiep, \phi oswatiaer rpe-
seckyio Gykey ¢, \delta — Gyxsy 5.

28 AHQIOTHYHO NOCTPONTS BO BTOPOil Aueiike rpadu W3MeHeHHs
Yrla NOBOPOTa 0GbEKTa, HCMOL3YS JaHHbE W3 MaccHsa Povorot, no-
JIyHEHHOTO B Pe3y.ITATE MOACTHPOBAHILS.
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>> subplot(2,1,2);
plot (Povorot (:,1), Povorot(:,2));
title( Povorot');

xlabel('Time, s');
ylabel('\delta, deg.');

>

Cronnposars monyuenusiii rpadik B (popmupye-
m Mbiii oTHeT uepes Gyep oomena (Edit=>Copy Figure)
JIH COXPAHHT €ro KAK PHCYHOK JUIA AaibHeiiueil BeTan-

ki B orser (File=>Save as.... pacupeiie jpg).
Tpuvep rpadikos ciruanon «Ynparienie oGsekros i «[Toso-
POT OBheKTa» NpHBCACH HA pCYHKe 6. JUis NPUBECHHIX TPAHKOR
GHUI0 BLNOTHEHO (POPMATHPOBANHE (10GABICHE! JUHMN COTKH, YBETH-
e TOJIUHA JIHHIH) ¢ IOMOULLIO COOTRETCTRYIOIIETO OKHA CROMCTE,

(View=>Property Editor).

Upravenie
5,
4
3|
£
1
of
1
o EJ 00 50 20 %0 0
Time,s
Povorot
2

o £ 700 50 0 %0 0
Time,s

Pucynok 6
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29 [lartee POBOJMTCA HCC/IENOBAHME CHCTEMbI YNPABICHHA 06~
eKTOM ¢ BHELINHM BO3ICIICTBHEM 63 HIMEHEHHS NAPAMETPOB Peryis-
topa. JList 9T0r0 B okHe mapameTpos Giioka Buemmee Bosieiicrame
& noze Final value yCTaHOBHTS Beliuiiy CHIHAIa, paBHyio 2 (410 Gy-
€T COOTBETCTBOBATE YTy BHEIIHETo BO3NENCTBUS 2°), W BLIIOMHHTE
MoAeHpOBaHe.

30 Mocwotpers pesybTatsi Moxenuposanus. Tpumep rpaduka
cnrnana «TToBOPOT OGHEKTa» IPHBEACH Ha PHCYHKE 7.

B nosopor obvexta =8 X
EOCERIFLLIETE] E

0 B0 100 150 200 250 @00
ime ot 0

Pucynok 7
M3 rpadika BHINO, 4TO MK BHELHEM BO3ICHCTRHI H HCIOTEI0-
sauni T1]1-peryiaTopa oBeKT He NOBepHYCA HA 3aHMki yro B 10°.
31 Tepeiir B komanasoe okio Matlab 1 anoMiTe pesyIsTaTs
MOACTHPOBAHIIS B HOBBIX MACCHBAX. OHH IOHAIOGKTC /U1 TOTO, 4TO0H!
‘CPABHHTS HCXOHBIIi H CKOPPEKTHPOBANHBII] BADHANTEI CHCTEMEL.
>> Upravl = Uprav;
Povorotl = Povorot ;
 fx >>
32 UroGkl eryIsTOp KOMICHCHPORLI HOCTOAHHYIO COCTARISIO-
LUylo BOIMYICHHS HYKHO AOGABHTH B HETO MHTErpAtBHBi Kamal.
Jls 9T0r0 B OkHe napamerpos Gioka PID Controller muGpars Con-
troller: PID, Form: Ideal u ycranosiTe 3nasenie napaserpa I:
1=1/T,=001.
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33 BANOMHITE MOJCTHPOBAHHE CHCTEMA! YIDABICHHS OGBEKTOM
¢ pueunmn BosjelicTauen npi ucnonssopaniy TTHJI-perynstopa. Tlo-
CMOTpeTs pesysTaTsl MosenHposanis. Tpivep rpaduka curnana ([lo-
‘BopoT oBkeKTa» cHeTems: ¢ ITHJI-peryIATopoN IpHBeeH Ha pHCYHKe §.

B nosopor obverm = )
ERIEEIFLIET R ~
185
| i
10
5
0
0 50 100 160 200 250 300
Time offset. 0 f
Pucynok 8

M3 rpadika BILIHO, MTO PEryJISTOp ¢ MHTCPAILHBIM KAHAIOM
CMOT KOMIIGHCHPOBATS TIOCTOSHHYIO COCTARIAIONLYIO BHILIHETO BOeHi-
CTBIA M OGBEKT NPHMEPHO Hepe3 230 ¢ NOBEPHYICA KA JATAHKKIIE YT
B 10°

34 CoXpaHUTS OKOHWATENbHYIO MOZIEM> CHCTEMS ympaBiemus
oGkexToM.

35 Tlepeiiu B komamzmoe okzo Matlab. octpouts B Bepxueii
“acTH rpadika KpHBBIC CHIHAJIA YNIDARICHHS TIOBOPOTOM OGBEKTA CH-
cremst ¢ I1JT-perynstopos u TTH/I-peryastopon, a B mkseli 4acti
TpagHKa KpHBbIE IEPEXO/THEIX NPOIIECCOB YIIIa 110BOPOTA OBHEKTa.

Jlns aT0ro B komanze plot ClEAYeT NePeIHCIHTE Hepes JANATYIO
BCe IAPEI MACCHROB, IDH STOM NIEPRAS MDA AOTAHA COOTBETCTBOBATE,
nepaomy rpadiky.

Ut paLIHAIS KpHBBIX L/IECOOGPATNO HCTIOBIOBATE asHiili TwIl
MW, 32/12BAEMBIX C TIOMOLIBIO HEOOAIATENBHEIX CHMBOMBHBIX Tepe-
MEHHEIX.
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>> subplot(2, 1, 1);
plot (Upravi(:,1), Upravi(:,2),
Uprav(:,1), Uprav(:,2), '--");
title('Upravienie') ;
xlabel('Time, 5'); ylabel('\phi, deg.');
legend( 'PD-Controller’, 'PID-Controller');
subplot(2, 1, 2):
plot (Povorot1(:,1), Povorotl(:,2), '~',
Poverot (:,1), Povorot(:,2), '~-');
title( Povorot 1) ;
xlabel('Tine, s'); ylabel('\delta, deg.');
legend( 'PD-Controller’, 'PID-Controller');

e >>

TpH TOMKH B KOHILE CTPOKH 0IHANAIOT NIEPEHOC KOMANIH! Ha Cle-
Aysouyio c1poxy. Konarza legend CiyskHT /15 BBIBOZA JQTCHIb — CHM-
BOTLHbIX CTPOK, OMHCHBAIONIX KaKTbIii H3 TIOCTPOGHHBIX TPAHKOB.

m Cronnposats uepes Gyep oGMena morysenmsii

rpadk B oraer. Tpinep rpadika MOACIH ¢ cemeiicTBOM
KPUBBIX TIpHBEIEH Ha PHCYHKe 9.

peaerie

P-Contoter
P Cortter

™

5 Coroter
PID Contter

E] o N I )
e,

PucyHok 9
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Hupusuayansuoe 3ajauue

enoaksys ykasauus, NpHBEACHNbE B ML 135, BHIOIHHTS MO~
AeaupoBaNHe MMHeliNON CHCTeMs! ynpasienns B nakere Simulink i
uaveHiii NAPAMETPOB GIIOKOR, BXOAALUIX B MOACIb, NPHBEACHHEIX
B TaGuMIe 2 B FABHCHMOCTH OT HOMEPA BADHANTA.

Tpuseante B orsete o 1aGoparopHoii padore:

— CIpYKTYpHYIO CXeMy HeceAyeMoli IMHeliNOli CHCTeMBI ynpas-
enis OGHEKTOM;

— nepeaaTouHsIe (yHKINMM GIOKOB JaHHOI CHCTEMB C mapamer-
DAMH B COOTBETCTBIM C BAPHAHTOM;

— PE3YILTATH MOACTHPOBAHHS W BEIBO/I 110 paGoTe.

KOHTpO/IbHble BONPOCH!

1. HajomiTe OCHOBHEIE ITAITSI CO3AAHHS MOZEIH.

2. Kax nomsiosarscs Simulink Library Browser?

3. Jlas wero npeanasnasiens: Gokw Transfer Fen, PID Control-
ler, Step, Sum, Scope?

4. Kaxne macrpoiiki umeiores y Giokos Transfer Fen, PID
Controller, Step, Sum, Scope?

5. Kak cKONMpOBATE W30Gpakenie Mofei B A0KymeHT Microsoft
Word?

6. Kaxue mactpoiiki HyxHo sazars B okwe Configuration
Parameters nepet 3anyckom MoAeH?

7. Kak mepeaTh pesyIsTaThl MOXETMPOBAHHS B PaGOuyiO 0G-
nacts, Matlab? B KaKo Bite oM nepesaiorcs?

8. Kakie napaveTpst npumact kosanza subplot?

9. Kak sanucsisactes kovarza plot?

10. Kak NOCTPOHTS B 01HOM OKHe 182 pasHAIX rpadika?

1. Kak Ha 0HOM rpajiKe I0CTPONTS HECKOTIEKO KHBHIX?

12, Uro Takoe nerena? Kak BuiBectH ereiay Ha rpaguk?
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3adanue K pasome: Mo unousudyansuoi cxewe annapama (sapuanm: 3ada-
HuS CHOMPU & npUTONCENUE) HEOGXOOUMO KpamKo omucamb mexnoTo2ue-
cKuii npowece; Kiaccuuuuposamy nepemennsie; swdeumy KaHaTHL 60IMY-
Wwenun u Kauarw ynpasienus, oGocwosams ux ewop. Cocmasums 6 sude

MaBue nepeuens KONMPOUDYENbIX U peyIUpYeNBLX napaNEmpos.

1A COCTABTEHHS MEPeNHA Ha KOHTPOTHPYEMSIE H PEryTHPYEMBIE IapaveT-
b HEOGXOHMO BOCTIOTHI0BATCA TEXHONOTHYECKOii cXeMoli annapaa. Tors3y-
Ch THAHHANH, TOMYHEHHEIMH B Kypee «TIpOLECCH M AMNAPATE XHMHIECKOH Tex-
HOTOTHIY, CTYIGHT OMHCHBACT TEXHOOTHYECKIH TIPOLIECC, BHGUPACT AHAMETPE!
YCII0BHOO MPOXO7A TPYGOMPOBOIOB, MATEPHATH, W3 KOTOPHIX H3rOTOBIEH! TPy-
Gonposozs! 1 T.1. B KauecTse KAHATOB YIPABTEHHE BHGHPAIOTCA T KAHATHL, e
110 3A7AHNIO TPEGYETCA MPEAYCMOTPET PEryIHPOBANKE, OCTATHHEIE CHHTAIOTCH
Kananaws posmymenns. TIo KOHTPOTEM MOHHMAETCS NOTyveHHe HA(OPMAIIH O
TOM WM WHOM MApAMETPE B BWIE MOKAIAHNA (Ha BTOPHYHOM HIMEPHTETBHOM
npuGOpe, AMGO HA BHACOTEPMIHATE), PErMCTPALIH (HA CAMOHCLE, THGO Meta-
TajoteM yCTpOFiCTBE), CHTHATHIALIH O BHIXOAE 32 TPAHMIIE IOMYCTHBIX FHatE-
il (CBETOBAS WITH IBYKOBAK CHIHATHIALA HA LIATE, THGO MHEMOCXEME TEXHO-
noreckoro npoitecca). KORTPOIO MO/VIEAAT Te NApaMETPH, HIMEPEHHE Teky-
X 3HAYERHIE KOTOPHIX OGAIErMaET MYCK, HATAKY  BEfEHHE TEXHOTOTHIECKOTO
mpotecca. K X wnciy OGHINHO OTHOCATCS BXOTHEIE BEMHWMHEL, TIDH HIMCHEHHI
KOTOPHIX B OGBEKT NOCTYNAIOT BosMymaiomme BostelicTains. Tlpw onepatisHoM
YMpABCHIH BOIMHKAET HEOGXOMMMOCTE KOHTPOTHPOBATS HaHGOIEE BAKHEIE BhI-
XO7IHBIE BETHIIHHHL, HATIDHAE, COCTAB H KOTHYECTBO MOTY9AENOTO FOTOBOTO PO~

JyKTa, ero Tesmepatypy, Aannenie i 1.0 C UETbI0 MOTYHEHHS AQHHEIX, HEOGXO-
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JUIMBIX JUTA PACHET TEXHHKO-IKOHOMHYECKHX TOKA3ATE el TAK K€ CTEAYET Kot-
TPOMPOBATE TaKHE MAPAMETP! KaK KOTHYECTBO MOTPEGIAEMOii IMEKTPOIHEpIHH,
Tenio- u xnazoHoCHTE e M 1.

K BHGOpY CHIHATHINPYEMEIX BETHIHH CTEAYET MPUCTYMHTS MOCTE AHATH3A
OGLEKTA B OTHOWICHHH €r0 BIPEIBO- H NOKAPOONACHOCTH, TOKCHYHOCTH  arpec-
CHBHOCTH NIEPEpABATHBAEMEIX MPOTYKTOB 1 APYTHX CrIEIHBHYECKIX 0COGEHHO-
cTefi mpow3BonCTEA. CHIHATH3AINN TIOUIEKAT NAPAMETPH, HIMEHEHHE KOTOPHX
MOKET NPHBCCTI K aBADHH HIH CEPBE3HOMY HADYIICHHIO TEXHOTOTIYECKOTO PO~
ttecca. K HiM OTHOCATCH, HATIPHMED, KOHIICHTPAIIHA B3PHIBOONACHEIX BEUIECTS B
'BOYIYXE NPOM3BOICTBEHNHX TIOMENEHHI, YDOBERb AIIIKOCTH WITH CHITYTHX Ma-
Tepuanos, nasnenwe, Temnepatypa i T.1. Takin 0GpaIOM, HEOGXOHMO mpeny-
CMATPHBATE TEXHOTIOTHYECKYIO CHTHATHIALNO, KOTOPAs BHINOTHAET POTTS TEy-
Mpexiers aBAPHIHEIX CHTYIIi H CHIHATHIANIO (IOTOKEHNEY, KOTOPas i~
(OPMHPYET O COCTORHIH KORTPOTHPYEMBIX OGBEKTOB H HTIEMEHTOB YTIpABTIEHHS.

B X07te aHATH3 TEXHOTOTHYECKOTO TDOLIECCa HEOGXOMHMO YCTAHABTHEATS
BOIMOKHOCTH AsBHTHS QBAPWIHBIX CHTYAUNH, 19BATh OUCHKY HX BOSMOKHBIX
nocTeACTBNIi ¢ UETHIO OMpeACAEHNS HAMGOTEE NOKASATENLHEIX XapAKTEPHCTHK
Mpotecca, KOTOPbiE MOTH Gbi GhITh HCTIONB30BAHS! /U1 MPOTHOSHPOBAHIS H Tpe-
Aynpex ez asapwi (cpAGATHIBAHHS CHCTEM ABTOMATHYECK O 3ALHTH).

Tlepetiens KOHTPOTHPYEMEIX H PEryTHPYEMSIX apaMETPOB JOTKEH BKIIO-
wat (cw. TaG.

~ HAMMEHOBAHHE KOHTPOTHPYEMEIX H PEryHPYEMHIX MAPAMETPOB C YKaza-
HHEM HX HOMMHATHHBIX IHQUEHWIi 1 IOMYCTHMHIX OTKIOHHWI, B C7yae npo-
TPAMMHOTO PEryTHPOBaHIS THAArAETC MPOTPANMA H3MEHEHHS apaMETPOB;

— U1 Ka/I070 HIMEPAEMOTO MapaMETPa YKATHBAIOT Ha  0GOPYOBAHHH
TOUKH OTGOPA HIMEPHTEITBHEIX HMITYTTECOB H MECTA YCTAHOBKH NEpBHYHbIX HMe-
prTenBRbIX npeoGpasoBaTereii (1aTIHKOR);

—HANMEHOBANHE YIPARIAIOUIX (PETYHPYIOUIX) BOYICHCTBM  Mec-
Ta YCTAOBKI PeryAHPYIOULITX OPFaHOB, AHAMETP TPYGONPOBOZOR;

~ XapaKTEPHCTHKY TEXHOTOTHYECKHX CPETl Hf MECTAX YCTAHOBKH MEpBH'-
HBIX H3MEDHTETHHEIX NIPEOGPa3OBaTE el H PeryTHPYIONIIX OFAHOB 10 HX KOppO-
IHOHHOIi AKTHBHOCTH, MOKAPO- W B3PHIBOONACHOCTS.




image46.png
NEPEYEHb KOHTPOJIMPYEMBIX H PEIYIMPYEMBIX TAPAMETPOB

aiicuon e obLekTa s upamien
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3adanue  pabome: OGocuosams ewGop KoMnaekca mexnuueckux cpedcms —
KTC 028 10Kansnoit cxewst QsmoMamusauuu u cxews asmoMamusaguu c
npumenenue MITK ~ wusponpoueccopnozo Kowmporiepa. PaspaGomams
cmpyxmypuste cxem KTC ACYTIL.

CIpYKTYDHbIE CXEMBI HIMEDEHIS H YIPABIEHHS OTHOCKTCA K KOHCTPYKTHB-
HBIM CTPYKTYDHBIM CXEMAM C Y7EMSHTAMH (DYHKUHOHATHHEIX MPH3HAKOB. DT
CTPYKTYPHHIE CXEME! PEKOMEHIYETCH BHTIOTHATS B COOTBETCTBHI C PYKOBOARIIM
TEXHIYECKIM MATEPHATOM «ABTOMATHIHPOBIHHEIE CHCTEMH! YTIDABTEHHSA TEXHO-
normecKii npotieccans. CTPYKTYPHSIE CXEMB! YIPABTEHHS i KoHTPOTs. MeTo-
Jutka opopsnesis (PTM 252.40-76 MunpuGopa).

Ha cTpyKTypHOIH CXeMe OTOGPAAGIOTC B OBUIEM BILIE OCHOBHBIE Pl
MpOEKTA M0 YHKIHORATLRO, OPraHMIALNOHHOI 1 TEXHHECKO CTPYKTYpE aB-
TOMATHSHPOBAHHOIi CHCTEMH YIPABTCHIA TEXHOTOTHYECKIMH Mpotteccarst (ACY
TI) ¢ coGmonerten HepapXHi CHCTEMSI, BIANMOCBE3EHi MEAZY MYHKTAMMH Kot~
TPOIS H YNPABIEHIS, OEPATHBHHIM MEPCOHATOM 1 TEXHOTOTHIECKIM 0GBEKTOM
ynpassiesns. TIPHHSTHIE NpH BHINOTHEHNH CTPYKTYPHOH CXEMS! MPHHIIMS Opra-
HUSQIMH OTIEPATHBHOTO YTIPABIEH IS TEXHOTOTHYECKIM OGHEKTOM, COCTaB 1 060~
IHUEHIS OTICTLHBIX YTEMEHTOB CTPYKTYDHOJi CXEMH JIOMKHEI COXPAHSTECA BO
BCex poeKTHAIX A0KyMenTax Ha ACY TII, B KOTOHIX OHi KOHKDETHSHPYIOTCS 1
AeranusnpyioTCs.

PasMepsi BeX YCIOBHHX 0GO3HAUCHII HE PErTAMEHTHDYIOTCA W BHGHpa-
HOTCA 10 YCMOTPEHHIO HCTIOTHHTEITS C COBTIONEHHEM OTHHAKOBIX PAIMEPOB /U5
OnHOTHIHBIX WIOGpaKERHi. B TeKCTE W HATMHCAX HE OMYCKAETCS COKpAIIEHHS
7108, 32 HCKTIOWEHHEM OBUIENPHAATEIX, A TAKAE YCTHOBIEHHHX B COOTBETCT-

‘BylouX cTaHAApTAX.
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Cmpyxmypusie cxewst Kounnexcos mexuuseckux cpedems u cpedems
asmovamusauuu.

B 3a1aHiH HEOGXOMHMO NPOW3BECTH BHIGOP H KOMTIOHOBKY arperaTiposa-
HBIX KOMILIEKCOB TEXHHWECKIX CPEZCTS H CPEICTB ABTOMATH3AIIN, T. €. Ha Gase
THOBHIX TEXHIECKHX CPE/ICTB Pa3PAGOTATS CTPYKTYHYIO CXEMY TEXHOOTHYE-
CKOTO KOHTPOAS H YNIpARTEHS ONPEETCHHEIMH NIAPAMCTPAMH 1AHHOTO 0GbeKTa
asTovaTHamM, CTPYKTYPHIE CXEMH KOMIUIEKCOB TEXHHYECKHX CPEACTS i
CPEICT ABTOMATH3AIIN KOHKPETHIMPYIOT TEXHHYECKHE PELICHIA, IPHHATHE TP
PaspaGoTKe CTPYKTYDHBIX CXEM HIMEPEHHS H YTIPABIHHS.

Ha CTpyKTypHOIi CXeMe arperaTHpOBAHHBIE  MOTYTHEIE YEMEHTH! KOM-
fleKca TEXHHNECKNX CPEACTB H CPEACTB ABTOMATH3AINH HSOGPAKAIOT B BIIE
MPAMOYTOTHHHKOB ¢ COOTBETCTBYIOUIMI HAATHCAMI HIH C YKAJAHHEM B HHX YC-
noBHBIX 0Go3avEHHi. Pacum(ppoBka STHX 0GO3HAUCHIIi ¢ YKAIAHHEM KX (ByHK-
il NPONIBOTHTCA B TaGHMIE, TIOMEMENHO HA MepTERE CXeMst. CBAIN MERIY
MEMEHTAMM CXeMBI HIOGPAKAIOTCH THHHAMH CO CTPETKAMM, NOKASHBAIONIIMI
"HATPABTCHHE MPOXOAIEHIS CHIHATOB.

Tipusep crpykTypHoii cxems: KTC ACY TIT yuacTka Genenns npencranien

wa puc. 1. Tipi paspaGoTke Hankoit CXeMbi GHUTH NPHASTE CTETYIOUIHE MPOCKT-
wste pemternis. Ha HIKHEM YPOBHE CHCTEMS! YIPABTCHHA MPUMEHEHE! JETHHKI
MEKTpHYECKHE € YHHIMPOBAHHbIH TOKOBEIMH BHIXOTHBIMI CHTHATa (Bi-
XO7IHbIE CHTHATH QHATIOTOBHIE % JATYHKOB TMTEpaTypH, pacxona, pH i T.1;
JUA 7ATIHKD METPAKa — BHXOTHO CHIHAT AMCKpETHI); MTHEBMATHYECKHE Pery-
TMPYIOIIHE  OTCEUHBIE KIAMANHI ¢ MEMOPAHHBIMI HCTIOTHHTETHHEIMH MEXAHH3-
MaMH, PaGOTAIOIIHE ¢ Y7IEKTPONHEBMONPEOGPA3OBATEAMH H YTIEKTPONHEBMOpETE.
Cpetmii YpoBEHS NPECTARTEH TEXHOTOTHIECKIM KORTPOTIEPOM MOHOGAOTHEIM
~ TKM-52, CoCTORUIM i3 NPOUECCOPHOTO MOZYA, MOTYTeii BBOZA-BHIBOTA K
GI0K KIABHATY S  HHHKAIIH.

Bepxuuii ypoBerh MPECTABIACT cOGO/i CTAHIMIO YNDABTEHI HIKeHEpa-
TexHon0ra, peanisopaniyio Ha Gase nepeonansHoii IBM, cHaGkenHyio myTsTOM

YTpABTICHIA, BHICOTEPMHUHATON H ICUQTAIONIM YCTPOICTBOM.
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‘3adanue K patome: Paspatomams u oropwums cxeww asmomamusayuu (10-
KAABHAA CXeNMA QEMOMAMUIANUN U CXENA QSMOMAMUSANUU € NPUMENCHUEN

MITK). Cocmasums eneuuduxauuu ua npusops: u cpedemsa asmomamusauu.

Cxevbi apTovaTHsamn.

CXeMH aBTOMATHHAUNH SBTAIOTCA OCHOBHBIM TEXHHYECKHM JOKYMEHTOM,
OMpeenAONIIM (yHKIHOHATEHO-G/I0HY O CTPYKTYPY OTACTBHBIX Y308 aBTOMa-
THYECKOTO KOHTPOIL, YNIPABIICHIS 1 PeryTHPOBAHIA TEXHOTOTIIECKORO MPOECca
 OcHAMmERHS OGHEKTa YIPABICHHA MPHGOPAMH  CPEACTBAMI ABTOMATH3AIHH (B
TOM HCIIE CPECTBAMH TENEMEXaHHKH  BIMHCTHTETLHOT TEXHIKH).

Tlpi paspaGoTKe CXeM GBTOMATHSAUNM (Paee MPHMEHATOCH HAIBAHHE 1
celitiac OO HCMOT3YETCA AOCTATOMHO LIHPOKO - (YHKUHOHATEHEIE CXEMHI ABTO-
MATH3AUHI) HEOGXOMIMO PENIHTS CEAyIONIHE Jazau:

* noyeHHE NEpBIIHOF HH(OPMALIH O COCTORHHI TEXHOTOTHYECKOTO PO~
necca  oGopyosas;
* HenocpexcTBeHHOE BoYIEiCTBHE HA TEXHOTOTICCKHiH MPOLIECE A YIpas-

e ;.

* CTAGHTH3AII TEXHOTOTHYECKHX NIAPAMETPOB Npotiecea;
 KOHTDOTb i CHPHATH3AS (€CTH 5TO HEOGXOMHMO) TEXHOTOTHYECKHX Na-

PAMETPOB TIPOIIECCa I COCTOSHH TEXHOTOTHYECKOTO 0GOpYI0BaH.

DYHKUNOHAIBHEIE 3a7atH ABTOMATIANN, KaK TPABILIO, PEATHYIOTCH ©
MOMONIBIO TEXHHYECKNX CPEZICTS, BKTIONAIOMMX B Ce0R: 0TOOPHEIE YCTpOiicTBa,
CpeficTBa MOTyNEHHA MEPBHUHON HHGOPMALIK, CPEACTB MPEOGPAIOBAHIS H Nie-
PepaGoTKH MH(OpMAII, CPEACTBA NPENCTABTEHNS W BHIAWH WHpOpMAIIH OG-
CYAMBAIOIIEMY TEPCOHATY, KOMGHHHPOBAHHBIE, KOMILIEKTHHIE H BCTIOMOTATETb-
e yerpoiictsa.

'Pe3yIILTATOM COCTARICHUA CXEM ABTOMATHSAIINH FBISIOTCH:
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1) BHGOP METOZ0B H3MEPEHHA TEXHOTOTHHECKIX APAMETPOB;

2) BHIGOP OCHOBHBIX TEXHIMECKHX CPE/ICTS ABTOMATH3AIIN, HAHGOEE MO~

HO OTBENAIOINX MPEBABIAEMEM TPEGOBIHHTM H YCIOBHSM PAGOT as-
TOMATHIHpYEMOTO 0GbeKTa;

3) ompesieneHHE MPHBOTIOB HCTIOTHTELHBIX MEXAHHIMOB PEryAHPYIOUINX,
760 3ATIOPHBIX OPFaHOB TEXHOTOTHYECKOr0 0GOPYAOBANHS:;

4) pasMellienHe CPECTB ABTOMATHSALIMH HA IUHTA, NYTSTAX, TEXHOTOTHYE-
‘cKOM 0GOpYA0BaHHI W TPYGONPOBOAAX M T. T  OMPEETEHHE CTIOCOG0B
MpeCTaB eI H(OPMALIHI O COCTORHHI TEXHOTOTHIECKOTO 0GOpY0-
sanms.

‘TeXHOMOTHYECKHE KOMMYHHKALIH  TPYGOMPOBOS! AWIKOCTH H rasa Hio-
‘GPAKAIOT YCTOBHEIMH 0GOSHANEHIAMH B COOTBETCTBIN C MpiToAenvem 3 TOCT
14.202.

TIpuGopsi, cpeACTBA ABTOMATH3AIIN, YTEKTPHIECKHE YCTPOFICTSA 1 SeMeH-
THI BHHCTHTEBHOI TEXHMKI Ha (DYHKIMOHATEHEIX CXEMAX ABTOMATH3AIIH 10~
KassiBaioTes B cootsercTani ¢ TOCT 21.404-85 1 OTPACHCBEIMH HOPMATHBHBIMI
HOKyMeHTaMH.

Tlpi OTCyTCTBNH B CTAHAGPTAX HEOGXOMHMBIX W3OGp@KeHHii paspemaeTes
MPHMEHATS HECTAHAAPTHbIE HIOGPAKEHIS, KOTOPHIE CTEAlYET BHINOTHATS A OCHO-
'BHMI XaPAKTEPHEIX MPH3HAKOB HIOGPAKAEMSIX YCTPOFICTS.

‘CXeME! aBTOMATH3AIIH MOTYT GHITh BHITOTHEHb ABYMS CTIOCOGAMM:

1) passepuyro ¢ woGpaskentien MITK, WIHTOB, NYILTOB YIPARICHIA, NpH TIOMO-
I YCIIOBHBIX TPAMOYTOTBHHKOB (KAK NIPABIIO, B HIDKHeETi YacTH UepTeia), B
TPEAETaX KOTOPOrO MOKATHIBAIOTC YCTAHABTHBACMHIE HA HHX CPE/ICTBA ABTO-
arsaun (cm. prc. 3  4);

2) ynpomeno ¢ W3OGPEKCHHEM CPEICTS ABTOMATHIAUMH HA TEXHOTOTHYECKHX
CXemax BOTH3H OTGOPHEIX 1 TPHEMHHIX YCTPOFICTB G¢3 MOCTPOCHHS MPAMO-
YTOTEHIKOB, YCTIOBHO H30GPEAIONIIX UIMTHY, MYTHTE 1 T4, (CM. pHC. 2).

TIpeiMyimecTBOM NepBOro CnocoGa ABTAETCA GOTBIAN HATTATHOCTS, B 3Ha-

wrenbRoil cTenemn obnervaiomas utenie cxemsi. TpuGopsi, BeTpanBaCMEE B




image52.png
TEXHOTOTHYECKHE KOMMYHMUKAIIHH, TIOKa3HIBAIOT B PATPHIBE THHHI WIOGpaKEHHS
TpYGONPOBOTOB; MPHGOPH, YCTAHABTHBAEMSIE HA TEXHOTOTHIECKOM 0GOPYIOBa-
HIHH MOKAIBIBAIOT PATOM. OCTATHHHE TEXHHNECKHE CPEACTEA IOKATHBAIOT YCTIOB-
HBIMIH TPAQHECKIMI OGOHATCHNAMI B NPAMOYTOTSHIKAX B HIUKHE]i HacTH cXe-
s, Tipamoyromssinki, wsoGpaatonie MITK, ImTsi, My7TST! pacnionaraior s Ta-
KOl MOCTIEAOBATENLHOCTH, WO b1 OGCCTIENNBATACh MPOCTOTA 1 ACHOCTS CXEMB! 1
MMM YM Tepeceue il Tl CBA3H. B KaAOM MPAMOYTOTBHIKE € TeBoii CTOpO-
HEL JQETCA €r0 HANMEHOBAHHE (3Ar0TIOBOK).

Tlpi BTOpOM CTIOCOGE 10CTHTGETCA COKPAIERHE 0GBEMA AOKYMEHTALIIH.
TIph 5TOM crIOCOBE MOIHIHORHBIE OGOTHAEHHS JEMEHTOB CXEM B KAKJOM KOHTY-
PE EryTHPOBNHS BHITOTHAIOTCA apAGCKMMH UHBPAMH,  HCTIOTHHTENBHEIE MeXa-

HIIMEL OGO3HAEHNS HE HMEIOT.

Hprezwamop.
Kaotowa
—
Cupe
—_
Kytouas
eudnocms

Puc. 2. TIpuMep BHIIOMHEHHS YIPOIEHHON CXEMS! ABTOMATH3ALMH
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Cocragenme creunguKaIM HA NPHGOPH! W CPEICTBA ABTOMATHIALMN

CriemipKaus na MpHGOPH 1 CPEAICTB ABTOMATHIALH BHINOTHASTCS N0
(popwe, mpeicTaBenHOii B TaG. 2. Ia OpMA MOKET GHITH PEKOMEHI0BANA TOTb-
KO0 13 yieGHBIX paGor.

B npasoii rpade "HoMep moSMIMH" YKATHBAIOT MOSMIMIO MPUGOPOB 1
cpenicTs asToMaTHsAWHK 1O cxeMe apTowarwiamn. B rpade "Hanwenosame 1
KPATKAY XapaKTEPUCTHK" YKA3HBAETCH HA3BAHHE PHGOPA, X0 TEXHHIECKHE Xa-
‘pakTepucTHKi 1 ocoBernocT. HanpiMep, AQTIHK /114 H3MEPEHNS THIPOCTATHYE-
cKoro nasnenns (yposis). B rpade "Twn npuGopa” yKassiBaeTes Mapka npuGopa,
‘wanpisep, Merpar-100-JIT. B rpae "TTphneuatne” npi HeoGXOMMOCTH yKasi-
sator "Tocrasnsercs B KowmiexTe", "PaspaGoTka CEUHATEHOTO KOHCTPYKTOp-
cxoro Giopo” s "PaspaGorka MTXTY" w Tak naree.

TIpuGops! i CpefiCTBa ABTOMATHIALH, YKA3AHHSE B CrieU KA, Creny-
T FpYNIHPOBATS 110 MAPAMETPAN HTH 110 YHKIHORATHHOMY TIPHIHAKY.

TaGmma 2
Criewukatuis wa IPUGOPS! H CPECTB aBTOMATHSAIN

Neuom: | Hamenonanne w sparian Tan upubopa | Koa-so | puse.

wewno | xapaxrepucruxa npudopa (vapwa)

KpaTkoe omueanie cxeMbl aBTOMATHIANIN

B naGopaToproii paGoTe CTYAEHT OTKER OBBACHNTS B CAATO popwe Ka-
Kie 37249 10 ABTOMATH3ALMH JAHHOTO TEXHONOTHYECKOTO OGbeKTa Ghum mo-
Cramnens: u kaki oGpasom pemiensi. TIoApoGHOE OMHCaRHE TOTO, KaK MPOXOHT
CHIHAT OT TOUKH HIMEpeHHA Yepe3 (YHKIORATBHHE GTOKH 710 MECTA MpHIOKE-
HUS YIDABTAOIIENO BO3ACHCTEHA (DETYAMPYIOWEro  Oprana) HYAHO CAenas
TOTBKO JUIA TEX KOHTYPOB, KOTOPHE ABISIOTCH HAHGOTEE OTBETCTBCHHEIMM i

Cl0KHBIM.
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‘3adanue k padome: PaspaGomams u opopyums npunuRNGTEHYE 1EKMpUNE-
cKue u nHeeMamuUECKUE cXeMb nUMANUA npUGOPOs U cpedcms asmoMamu3a-
Wuu, cocmasums nepeuens 1emenmos cxew (no cxeme asmomamusawuu c

npunenenuen MITK).

TIpHHIUNITHATH HEE HTEKTPHUECKHE CXEMBL.

TIpHHIUHMHATBHbIE CXEMb COCTABAOT Ha OCHOBAHHH CXEM ABTOMATHALIH,
HCXO/A 3 301QHHBIX ATTOPHTMOB (DYHKIHOHHPOBAHI OTACTHHHIX YITIOB KOHTPO-
%, CHHATH3IUH, ABTOMATHYECKOTO YIPABTEHHA  OGUIIX TEXHHYECKHX TpeGo-
‘BaHMi, NP THABIAEMBIX K ABTOMATH3HPOBAHHOMY OGBEKTY.

PaspaGoTka MPHHIMIHATSHEIX STEKTPHHECKHX CXEM BCETTIA CONCPAMT Orl-
PEAICTIEHHBIE YMIEMEHT! TBOPYECTEA 1 TPEGYET YMEIOTO MPHMEHEHIS STeMeHTap-
HBIX SMEKTPHYECKNX Heneli W THTIOBSIX (YHKINMOHATHHIX Y3708, OMTHMATsHOT
'KOMTOHOBKH WX B E/IHHYIO CHCTEMY C YHETOM YIOBTETBOPCHHS MPETBABIACMEX K
cXemam TpeGOBaHHIL, A TAKKE BOIMOKHOTO YIDOUICHNS M MHHUMH3AIIN CXEM
CxeMa fOmAHA OGECTICHHBATS BHICOKYIO HAIEAHOCTS, NPOCTOTY H SKOHOMHY-
HOCTS, 4eTKOCTS A1EfiCTHIE NIpH aBAPHIIHBIX PEAMMAY, YAOGCTBO ONIEpATHBHOl pa-

GOTHL SKCILIYATALIIN, HCTKOCTS OGOpMICHA

Tpaguieckoe 0OpITEHNE IPHHIHIHATLHEIX VIEKTPHIECKHY CXeM.

Venousie rpaduueckue oGosatenns Srementos cxew. Tpaiieckue 0Go-

IHAYEHIS IEMEHTOB CXEM YCTAHABTHBAIOTCA TPYMNO CTanAapTOB «OGo3HaseHHS
yenosasie rpadteckie B cxemaxy: TOCT 2.721-74 (oGoswasenns obuero npi-
enenns)  pazio apyrix TOCTos.

Obue npasina BeMOTHEHNA CXeM ONpenenAIOTCH crannaprasi: TOCT
270184 «Cxemst. Bist  Tunsi. OBume TpeGosanms k sunonermion; TOCT
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2.702-75 lIpasuna BemoHeHIA SneKTPHEcKMX cxen; TOCT 2.708-81 «lpa-
‘BHIA BEITIOTHEHIS Y7IEKTPHYECKHX CXEM HPOBOF BEHCTHTENBHOT TEXHIKI.

B Tex CyuasX, KOTIA BOIHHKAET HEOGXOTHMOCTS B MPHMEHCHIH KaKiX-
760 rpapwecKiX HIOGPAKERNH, He MPEAYCMOTPEHHHIX CTAHIAPTAM, TOTA 210~
YCKAETCR NPHMERSTS He CTARAPTH3OBAHHEIE TPAGHYECKiE 0GOIHAYEHHS, Mpi-
'BOA IPH ITOM HEOGXOMMHIE MIOACHEHH Ha cXeMe. VCTIOBHHE rpadiieckhe 0Go-
IHAYEHIS HMEMCHTOB, PAIMEPH! KOTOPHIX B CTAAPTAX HE YCTAHOBTEHSI, H306pa-
QUOTCH Ha CXEMAX B PASMCPAX, B KOTOPHIX OHH BHIMOTHEHb! B COOTBCTCTBYIONIX.
CTanzapTaX Ha yeT0BHbE rpadHECKHE 0GOSHATCHIS.

JlonyeKaeTes Bee IHANCHNA TPOTIOPUNOHATHHO YMEHBIIATS, OZHAKO MpH
ITOM MPOCBET MEALY ZIBYMS COCETIHHMH THHHAMH YCTIOBHOTO TPaiecKoro oGo-
Imavenns fomKen GbiTh He Mewee | v, Pa3Mepst YCIOBRBIX rpaiieckix 0Go-
Imaueril MOKHO  YBETHTHTS, €CTH 510, HATIPHMED, HEOGXOTHMO /UTA BIHCHBA-

IS B HIX TIOSCHSIOUUX THAKOB.

OGoznatenne uenei

OGosHateHHe yACTKOB Hereil CTYAHT /LIS HX OTIOIHANNS 1 MOKET TaKKe
OTpKAT HX (PYHKINOHATEHOE HaHAUEHHE B YMEKTpiUECKoli cxeme. TpeGosaris
K 0BO3MauCHIO ereli MPHAINMITHATOHIX HMEKTPHYECKHX CXEM ONpEIEneHEt
TOCT 2.709-72. Cornacko IToMy CTAHAGpTY BCE YHaCTKH MEKTPHYECKHX teneil,
Pa3IereHHEIE KOHTAKTAMH AIMAPATOB, OGMOTKAMH perie, NPHGOPOB, MALIHH, Pe3i-
CTOpAMH 1 APYTHMH YTEMEHTAMN, IOKHE HMETS pasHoe oBo3HadeHHe. V4acTki
e, NPOXO/AIIHE Hepe3 pasbemHBie, PA3GOPHSIE HTH HEpa3GOPHEIE KOHTAKTHEIE.
‘COETMHEHIS, IOMKHEL HMETH OTHHAKOBOE 0GO3HAYEHHE.

Jlna 0GosHaeHIA Y4ACTKOB Heneil MPHHIMITHATSHBIX STEKTPHYECKHX CXEM
npuMensioT apaGekie LA H npoMHCHHE Gykal naTHHcKoro andasuTa. Llg-
bt GyKBbi, BOTAUIIE B OGO3HAYCHHE, CTEAYET BHMOTHATS OTHIM PAIMEPOM
wpudra.

UremHe NPHALMITHATNEIX CXEM 1 0COGEHHO IKCTUTYATAIIS HTEKTPHICCKIX

YCTAHOBOK SHAMHTENHHO YNDOUIATCS, €CTH MpH PATAGOTKE CXEMBI MPOHIBOTNTE.
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oBosHaucHHe uenei N0 (YHKIHOHATLHOMY NIPUSHAKY B SABUCHMOCTH OT X Ha-
anaserns. TaK, HATDHMED, MOKET GHITH PEKOMEHI0BAHO /1A Leeli ynpasieris,
PEryHpOBANMS  HIMEDEHNA HCTIONK30BATE rpymy icen 1-399, An emeit cur-
wamsatn 400-799, An% ueneit muTasns 800-999. Buecto rpynn wp ywk-
HORATB AN MPHAATUIEKHOCTS ENEi NPHHLMITHATLHO CXEMH! MOKET GHITH Bhi-
PaKeHa W YCIOBHO MPHAATEMH GyKBaH.

Obute emy MHTAIS TIEPEMCHHBIM TOKOM MAPKHDYIOTCH GyKBas, 060-
amauaonm dasst (sanpusep AS00, BSO1 1 7.1). Hysesoii nposox Mapkmpyer-
s ¢ n0Gasnermen Gykabi N.

CHIOBHIE HEMH MOCTOAHHOTO TOKa 0GO3HAAIOTCH: HENETHEIMM THCTAMH —
Y9ACTKH Ueneli NOAOKHTE 5Ol OAPHOCTH, HETHHIMH — YHaCTKH eneli oTpiLa-
TemsHoi noAApHOCTH.

TocrenoBatensHocTs 0GosmateHHii OMKHa GHITh OT BBOAA HCTOUHMKA M-
TanWs K MOTPEGHTENIO, @ PASBCTATAIOIECH YIACTKH 0GOIHANAIOT CBEPXY BHIS B
‘HATpABTCHIH CriEBa HAMPABO.

Ha prc. § MpeCTaBTeH (BParMeHT MPHAIMIHATEHOH YMEKTPHIECKOH CXEMEI
pacnpenemensHofi cerw. B 1a60paTopHoii paGOTE CTYICHT 0TKEH B COOTBETCT-
i co cxewoii asTomaHsawm ¢ npumenernes MITK paspaGotaTs cxeny ek-
TponHTaHHA MPHGOPOB K CPENCTB aBTOMATH3AIHH. CXEMA JOTIOTHACTCS TIEPEdHEM
MEMEHTOB, Tle NPEYCMOTPEHO MOIMIHORHOE OGO3HANEHHE, HAMMCHOBAHHE,
KPATKAS XapAKTEPHCTHKA H KOTHYECTBO BCEX HEKTONOTpEGHTE el CXeMb ek~
TpommTanus (cM. Tab. 3).

TaGmima 3
Tlepestens SeMEHTOB MPHAIMHATLHOH YTEKTpHIECKOi
cXemst pacnpenenHTesHoli ceTi
Tlomm. ‘Haneroanie n Kparkas Kon-so | Mpivesaniie

obosmaters xapakrepucTika
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OQopILTEHHE IPHHINIHATLHEIX IHEBMATHECKHY CXEM.

TIpHHIMIHATEHbIE MHEBMATINECKHE CXEMS! COCTABIAIOT Ha OCHOBAHHI
YHKUMOHATHHBIX CXCM ABTOMATHSALNH, HCXOA W3 3AAQHHbIX ATTOPHTMOB (yHK-
HOHHPOBAHIA OTACTHHBIX Y3708 KOHTPOTA, CHIHATH3ALIHH, ABTOMATHYECKOTO pe-
TYHPOBANHS H YMPABTEHHS  OBUIX TEXHHYECKHX TPEGOBANN, NPETLABIAEMEIX
K aBTOMATH3MpOBANKOMY ObekTy. TIDHHIMTHATEHbE CXEMS! MHEBMOTHTAHHS
BHIOTHAIOTCA, €CTH B CHCTEME YNABTEHHA NPHCYTCTBYIOT NHEBMATHSYCCKHE
‘MpHGOpHI 1 cpeACTBa aBTOMATHIAK. B NOCTIETHEE BPEMS MHEBMATHYECKHE MPi-
‘GOpEI H CPEZICTBA ABTOMATHIALH BHITECHAIOTCA SEKTPOABTOMATHKO, HO Pery-
HPYIOUIHE PPN € MHEBMONPHBOOM He CAAIOT CBOWX MOSHILM M T10-TPEAHEMY
MPOKO BHITYCKAIOTCA KAK OTEHECTBEHHON, TaK i 3apyGeAHOH MpOMBIILTEHHO-
cTsio.

Ha prc. 6 7aH MpHMEp BHTIOTHERHA MPHHIIHATEOH CXEMEI THEBMOMHTA-
HEA, TIC ANMTAHN 7BA MHEBMONPHEMHNKA: STEKTPONHEBMOMPEOGPAIOBATETD
I1-1324 w snexrponsesmopere P-S0A.

DOpMA BHINOTHEHHA NPHHIMITHATHHEIX THEBMATHYCCKHX CXEM JOTAHA

CTI0COGCTBOBATS OGEIUEHHIO MPOIIECCa WX STEHNS, YCBOCHHS H aHATH

Tipus-
HTHATEHBE MHEBMATHECKHE CXEMbI BHITOTHAIOTCA Ges yueta wacurraGa.

MCTOTHHTENbHEE MEXAHIIMEL H PEryIMpYIOUIME OTahi, KAK Npasiio,
m3oGpaKatoTcs ycnoBHsMM oGosHasermai o TOCT 21.404-85. Tlpw simonme-
HIHH MPUHIMTHATESIX THEBMATHIECKHX CXEM NHTAHNA ATApaTypy H TPYGONpO-
BOBI CXEM NHCBMOTIMTAHIA PEKOMEHIYETCH WIOGPAKATH YCIOBHIM rpadise-
‘CKMMH 0GO3HANEHMAMH B COOTBETCTBHH cO creayiomui TOCTav: bt Bo3-
Ayxa — TOCT 2.780-68; peaykTop Aasneus sosayxa — FOCT 2.785-70; sewtins,
sanopwsiii (kpan mpoxoawoii) — TOCT 2.785-70; kpan Tpexxososoii — TOCT
2.785-70; Manowmerp komTponssii — TOCT 21.404-85; TpyGonposox cxaroro
sovayxa—TOCT 2.784-70.

TpyGHsie THHIH CBA3H HA NPHHLMITHATHHEIX THEBMATHYECKX CXEMAX 110~
Ka3HBAIOTCA CILIOIHOI OCHOBHOIE THHHEH, @ BCTPEUAIOWIHECH B HEKOTOPHIX CXe-

MaX TEKTpHECKHE EMH — UITPHX NyHKTHpHOF. MapKkHpyIOTes TpyGHie s
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CBA3H HA NPHHIMMHATLHAIX NHEBMATHYECKHX CXEMAX 1HGPaMH 1o nopsky. Bee:
"HOMEpA, NPHCBOEHHBIE MHEBMATHAECKHM THHHAM CBA B NPHAIMIHATOHHIX CXe-
MaX, COXPAHSIOTCS BO BCEX OCTATTHHHIX CXEMAX MDOEKTA.

B paspaGaTHBACMBIX NPHHUMITHATHHEX NHCBMATHYECKHX CXEMAX MOTYT
MPHMEHATECA CACAYIONIHE COKPALIEHHEIE MOSHINOHHEIE OGO3HANEHNS TPHGOPOB 1
CpENICTB MHEBMOABTOMATHKI: P—pEryISTOp (B CXEMAX NHTAHWA - PEAYKTOP):
PC — perynstop cootnomerns; KP—Koppextupyrouuii perynsop; PO — peryi-
pytounit opram; BUIT — sTopusmstii wswepwensisii npuGop; JI — raramk;
MY -~ mwmeputenshoe ycrpoiicrso; MM —  MCrOmMMTENBHE  MexaHU3M;
CY- cramms ynpastemns; P3 — pywwoii sazavamk; Tl — mosuumosep;
© — usp (B CXeMax mHTaNN); B~ BEHTITS (B CXEMAX THTAHIR) 1 T.1.

Bo BTOPOii HACTH TIOSHINOHHOTO OGO3HANEHHA OGHITHO YKATHBAETCH MO~
PAAKOBHIIi HOMED MEMEHTA B NMPEIETAX MEMCHTOB IAHHOTO BWIA, HANPHMED:
JUI, 2 1 7.1, Bee MOMMEHOBAHHHIE STEMEHTE CXEMbI (PEAYKTOPH, HIBTPEL, Ma-
"HOMETDH, BEHTILTH 1 T.1.) OTAHb! GBITS BHECEHEI B MePeteHs ANMAPATYPH! THEB-
MomHTasis (cM. TaGn. 4). B nepeune A0MKHO GhITh 19HO 0GOIHATEHNE HMEMCHTA
CXEMBI, €O HAMMEHOBAHHE W TEXHHUECKAS XapAKTEPHCTIKA, THI, KoTH4ecTso. B
‘MpHMeaHIH OGHITHO YKA3HIBAETCA KOMILIEKTHOCTS MOCTABKH.

BOYIYXOBOH Ha NPHHIMITHATHOI THEBMATHYECKOTi CXEME THTAHIA TIO3H-
IHOHHOTO 0GO3HANEHHS HIH MAPKHPOBKH He MMEloT. OIHAKO Ha BCEX KOIEKTO-
PAX 1 BO3AYXOMPOBOZAX OT HCTOMHHKA MHTAHHS 10 MOCTEAHETO JANIOPHOTO Oprana
HA OTBETBICHHAX K MHEBMONPHEMHHKAM JIOKCH GHITh YKA3QH PAMEp YCTIOBHOTO
npoxoza TpyGonposoza.

TaGmima 4

Tepesens annaparyps: THeBMOMHTaIS

OGosma- Hamvenosanue, Tun | Kon- | Tpuseuarne
erme TexHMteCKAs XapaKTepHCTIKA. 5o
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3adanue K paGome: PaspaGomams u oopuums cxemy enewnux nposooox,
cocmasums nepeuens yemenmos (no cxese asmoMAMUSAUL ¢ NPUMEHEHUEN
MITK).
CxeMt coemenl BHEUIHIX MPOBOTOK — 5TO KOMGHHUDOBAHHAA CXeMa,
Ha KOTOpOl MOKA3AHH YMEKTPHYECKHE W TPYGHSIE CBA3H MEATY MPHGOpAMH 1
CPE/ICTBANI ABTOMATH3AIINH, YCTAHOBTCHHEIMH Ha TEXHOTOTHYECKOM 0GOpY0Ba-
HIH, BHE LITOB M H UIMTAX, & TAKAE NOAKTIONEHHS NPOBOOK K MPHGOPA i 1t~
Tam.
CXeMbI CoeHENNil H MOTKTIOUCHHA BHEINHHX MPOBOZIOK BHIOTHAIOT Ha
‘OCHOBAHHH CTEYIOUIIX MATEPHATOB:
© CXeM ABTOMATH3AIIH TEXHOTOTHYECKHX POIIECCOB;
© MPUHIMTHATOBIX STEKTPHICCKAX H MHEBMATHYECKHX CXEM QBTOMa-
Tusaunm;
+ IKCTTYaTaIHORHO/ IOKYMEHTAIH HA IPHGOPS! H CPEACTBA ABTOMA-
TH3AK, MPHMEHEHHbIE B NPOCKTE;
© TaGmn coemHeHMIi W TIOAKTIONENNS MPOBOTOK WHTOB W MyTHTOB,
"BHIOTHAEMSIX B COOTBETCTBMH C yKasamami PM4-107-77;
© uepTexeli PACTOTOKEHNS TEXHOTOTHWECKONO, CAHTEXHHYECKOTO,
IHEPIETIIECKORO H Ap. 0GOPYZ0BAHHS 1 TPYGOTPOBOOB C OTGOPHEI-
MM 1 IPHEMHEIMH YCTPOTICTBAMH, @ TAKAKE CTPOHTEBHBIX HepTeAeii
€O BCeMH HEOBXOMMMBIMH /U1 TIDOKTATIKH BHEIIKHX TDOBOZIOK 33~
KNQIHBIMH # TPHBADHBIMH KOHCTPYKIILAMH, TYHHENAMH, KaHATAMH,
mpoesaM T, 2.
CXeMt coenHenyii BHEWHIX MPOBOZIOK B OBUIEM CTYHaE AOMAHA COTEp-
KaTh: MEPBHIHHE MPHGODH; UIMTH MYTSTH; CTATHBEL; BHEUITOBSIC MPHGOPH
pYNIIOBBIE YCTAHOBKH MPHGOPOB; BHEIIIHHE YMEKTPHIECKHE H TPYGHEIE TPOBOKI;

3AUNTHOS 3aHYICHHE CHCTEM ABTOMATHIALIH; TEXHHUCCKHE TPEGOBAHNA; Nepe-
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uenb 3nemenToB. [Ipivep cxeMst npuseack Ha puc 7. B aannoii cxeme saneiicT-
'BOBAHB! JGTANKH TEMNEPATYPH, PACXOZ, KOHUEHTPALNH, KTANAK MHEBMATHYE-
cxui perynupyiounii (103, 18), 218€ CoETMAHTETBHEE KeMMHbE KOPOGKH — KCK-
§ I NHEBMATHECKAR COCAMHHTEbHAL KopoOKa — CK-7. JlaTank Tesmepatypst
"MOZKITIOMEH 10 TPEXTIPOBOTHOH CXEMe, AATIHKH PACXO/A 1 KOHUSHTALIHH 10 Wi~
THpexnposozoii cxeme. Haopmats ot natikos noctynaer ua MITK. Tira-
HiHE JATIHKOB C YHHQUIMPOBAHHEIM BEXOTHHIM CHTHATOM OCYMIECTAISETCH OT
wmwra mTasms.

Tlepaianbie NPHGOPS # HCMOTHWTENbHHE YCTPOWiCTBA  HIOGp@XAIOTCS
BBEPXY MOX TAGAMICIH C MORCHAIOWMNH HAAHCANI (HIH B 3EPKATLHOM 30GPa-
Kewn B3y HAX TaGTHEli NoACHIoX Kanmmcei) o TOCT 21.404-85 (wn
OCT 36:27-77).

s, mynsTst, cramusst, MITK #30GpaRaior B Be IPAMOYTOTHHAKOB B
cpeameii acTH depTeRa (MpH PACTIOTOKCHIH TAGTHIS C MOACHAIOUIIMH HAAMH-
CAMM CBEpXY H CHI3Y MOTA MEpTERa) WIH B HIKHEH 4aCTH NOTA deprexa (mpu
PACTIOTOKeHIM TAGTHIS TOTHKO CBEPXY). BHYTPH MPAMOYTOTBHNKA YKasHBaETeS
HaMeHOBaHve mHTa, NynbTa, cTaTHBa, MITK. Pasueps mpAMOYroMsHIKOB mpo-
M3BOTHHIE, AOCTATONHEIE U1 PA3MENCHH K HIX HE(OpMAIIH.

BuGop npusozios  kaGeneii, a TakKe Cr0COGA BHINOTHEHHA YMEKTPONPO-
BOTKH MPOMSBOZAT B COOTBETCTEHH C YKASAHWAMH YKOBOIFUIENO MaTepHana
PM4-6-84 ([TpoeKTHPOBaFHE HTEKTPHIECKHX  TPYGHEIX MPOBOTOK CHCTEM aBTO-
aTwsaum. Hacts 1. DEKTPHIECKHE TPOBOAKID).

BHGOp TPYO NPOH3BOAAT B COOTBETCTBHI C YKA3AHHANH PYKOBOTAIETO Ma-
Tepuana PM4-6-79 «[IpOCKTHPOBAHHE STEKTPHIECKHX H TPYGHEIX NPOBOOK.
Yacts 2. TpyGHsie nposoKin.

TlHeBMaTHYECKIE COSTHHNTEbHEE KOPOGKH H3OGPEKAIOT B BHAE MPAMO-
yrombHiKa. B MECTAX BBOTA OZMHOMHEIX TPYG MOKA3HBAIOT NMEpeGOpOUHBIE CO-
eqMHITENH, @ B MecTe BBOZA MHeBMOKaGens — canbwikn. Ha momkax mummi-
‘BBIHOCKH YK3HIBAIOT THIB COSTMMWTENE/i H CATHHHKOB. DEKTPHYECKHE COCTH-

HHTETBHBE KOPOGKH H3OGPAKAIOT B BIIE MPAMOYTOTHNKA, BHYTPH KOTOPOTO
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PAIMEINAIOT CGOPKH 3AAKMMOB C HEOGXOAHMOIi HyMEpaIlieii H NIOKAHIBAIOT N0~
KIOUEHNE K HIM AT KaGereil (POBOTOB) ¢ COOTBETCTBYIOMIEH MApKUPOBKOiL
PA10M TakKe YKATHBAIOTCH THITS! CATHHHKOB.

Oxomo rpadpmteckinX 0Bo3HAYEHHIi COCAMMHTENBHEX 1 MPOTKHEX KOpO-
GOK YKaIBIBAIOT HX OGOIHANEHIS W MOPAAKOBEH HOMep, Hanpivep, KCK-24 Nl
KpoMe 5T0r0, /115 KaA10fi MPOBOAKH NIPHBOTIAT €€ TEXHHNECKYIO XAPAKTEPHCTHKY:
JUI% MPOBOIOB — MapKY, CeveHHe, PACUBETKY (pH HEOGXOMOCTH), A TaKIKE /UTH-
Hy: 1 KaGerteli — MapKy, KOTHYECTBO W CEHEHHE AIUT  NPH HEOGXOTHMOCTH KO-
IIMECTBO AHATEIX I, KOTOPOE YKATHBAIOT B MPAMOYTOTBHIKE, CIPABa OT 060~
IHAUEHIS TAHHBIX KAGETA; JUIA METATIOpYKABA — THI W JUTHHY; /U1S TPYGs! — ia-
METP, TOMRY CTEHKH H JUTHRY; /U1 THEBMOKAGENEH — MAPKY, KOTHIECTBO TPYG,
X THAMET], TOMIHIY CTEHKH W /UTHHY.

CXeMa JIOTIONHACTCA TEPEUHEM HMIEMEHTOB CXEME BHEIIWX MPOBOMIOK
(cm. TaGn. 5). B mepeuse AOTKHb GHITH yKazaHH B creAyIOmEl NOCTEN0BATE -
HOCTH: KaGenw, POBOAA, TPYGONPOBOTH, COETMHNTENBHEIE W MPOTHAHEIE KOPOG-
K, 3anopHas apwarypa. JUTA BCEX HMEMEHTOB JOMKHO GHITS MPHBEZIEHO MOTHI-
OHHOE OBO3HANEHHE B COOTBETCTBINH CO CXEMoli; HAHMEHOBAHHE  KPATKAR XapaK-
TEpHCTIK, KOTHYECTBO, THGO METPA (ECIH Pedts WIET O KaGersHoli MponyKIH,
mpoBozax H 1)

TaGmima 5
Tlepenens EMEHTOB CXEMS! BHEIIHHX NPOBOTOK
Tosm. ‘Haierosanie u Kparkas Kon- | Tipu-
oBosHa- xapaktepucTika 80 | mewa-
uenms e
KaGens KOHTPOTSHEIH C METHBINH AHIAMH, H3OMAIA
3 OTHBHHITX 10D HOTO MAACTHKATA,
06010%Ka 3 NOTHBHHWTXIOPHIHOTO MIACTHKATA
1-3,5,6 [KBBL 4 x 1.0 50w
7 |KBBL5x 1,0 20w
4 [KBBF10x 1.0 20w
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Pitc. 7. TIpiep BHITIOTHEHHS CXEMS! BHEIIHHX IPOBOTOK
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Tpraowenue

Jananme Ne 1 (puc. 8)
Tas Tonka
—a
Bosayx
—_————

Puc. 8. TexHOIOMMMECKAs CXEMA TONKH

TIpeycMOTpETS: H3MEpEHHE PACXOTA Fa3a W BO3IYXA KA FOPETKY; Eryi-
POBAHHE COOTHOIEHHS ra3-BoYIYX 1+3; PEryTHPOBAHHE TEMTIEPATYPHI B TOMKE —
1000 £ 10 °C; GroKkupoBKy noawi ras NP NAICHIHH PAIPEKESHUS B TOMKE —
50 KIIA.

Jananme Ne 2 (puc. 8)
TIpeyeMOTpETS: H3MEpEHHE PACXOTA T30 PEryTHPOBIHHE COOTHOIEHHS

ras-sosayx 1+3; perymposanite Temmeparypsi & Tonke — 900+ 10 °C; Grokuposky
MOZANH Ta3A MPH OTCYTCTBHM 1ABTCHIA B THHIH NOTATH Fa%a.

3ananue No 3 (puc. 9) k. Bo3ayX.

Kowzencar

Puc. 9. TeXHOTOIHNECKAs! CXEMA ILTOCOBKH

TIpeaycMOTpeTS: peryIHpoBaiie TemmepaTypsi 8 mriocoske — 40 + 2 °C;
perynuposatue yposas 5 Barse 0,8 + 0,02 M; PACXOT N1apa — KOHTPOTS K CyM-
MHpOBaHIe; GTOKHPOBKY TIOZIa4i CAGTOTO BOYIXa, PACTBOPA H MDA MPH OGpHIBE.
Tiarm.
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anamue Ne 4 (puc. 9)

TIpeayCMOTpETL: peryIHpoBaRKe TeMnepaTypsi B mmiocoske — 30 + 2 °C;
KOHTpOIS ypoBHs B BarHe 0,8 - 0,9 M; PEryIMPOBAHIC BIGKHOCTH TKAHH HOCE.
omkiva 80 £ 2 % 30 CYET MOTAH CAATOTO BOYIYXA K JBYXBATHHOMY OTAHMY;
GIOKHPOBKY NOZQ4N Mapa N MATEHWN JABTCHHA HA MapompoBoTe HiKe 0,3
M.

3anamme Ne 5 (puc. 9)

TIpeayCMOTpET: KOHTPOIHpORAHHE TeMnepaTypsi B miiocoske 40 - 50 °C;
perymuposarme yposns B Bantie 0.8 = 0,02 \; PeryIHpOBaHHE PACKOTa CKATOTO
BOYIYXa K 7IBYXBATSHOMY OTAHMY; KOHTPOTHDOBAHHE JQBICHNS HA APOTIPOBOTE.
0,6 +0,02 MIla; GroKHpOBKY NOAG4H apa NpH NAZEHMH AQBIEHNS Ha MAPOTPO-
‘Boze Hinke 0,3 MITa 1 Tesnepatype B kpaciistoii sanne mitke 40 °C.

Jananwe Ne 6 (puc. 10)

Hexommas cmecs

—

Pitc. 10. TexHOMOrHHECKAR CXEMA HH3a PEKTHHKAIOHHOT KOTOHHE

TIpeaycMOTpeT: peryHpoBaKHe TemmepaTypsi B konomke 80 + 5 °C; pery-
poBane ypoBi B KyGe Kookt 400 + 40 MM; KOHTPOTS CYMMAPHOTO pacxoa
HEXoTHOIi CMecH Ha aMNApaT; GIOKMPOBKY NOTAYH NAPA W HEXOAHOI CMECH mpi
Temnepatype B kononne Hike 75 °C.

3anamme Ne 7 (puc. 10)

TIpeaycMOTpeT: peryHpoBaKHe TemmepaTypsi B konomke 80 + 5 °C; pery-
mupoBase ypoBia B KyGe Konowtst 400 40 MM; PEryTHpOBAHHE PACXOTA HCXOT-
Hoii cnecH 0.5 % 0,02 a/aii; GTOKHPOBKY NIONGYH 1apa MPH NACHHI ABTEHHS
Ha naponposoze Hike 0,5 MITa.
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3ananwe Ne 8 (puc. 10)

TIpeaycMOTpeTs: perynHpoBanie Temmeparypsi B konose 90 + 5 °C. kon-
Tpors  cHrHATIAUNS YpOBHA B KyGe KonowHsi 200 - 300 M perympoaHe

pacxona nexomwoii cmeck 0,7 + 0,02 a/witi; GAOKHPOBKY MOTAH NAPA MPH PACXO-
e nexoHOfi execH mike 0,68 1/,

3ananme Ne 9 (puc. 11)

e e—
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Puic. 1. TexHOMOMH4ECKas CXeMa EMKOCTHOTO XHMH4ECKOTO PEakTopa

TIpeaycMOTpeTS: peryTHpoBaKKe Temneparypsi 8 peakrope 80 + 5 °C.; kon-
TPOAMPOBaNHE H CHIHATHIALIA YPOBHA CPEst B peaxtope 1.6 + 0.2 ; KoHTpomI-
pOBalHe PACXOAA HCXOHOI cMecH Ha peaktop 14 + 16 m'/a; Grokmposky noxawn
MCXOTHOI CMECH Ha PEAKTOP NPH MAZISHHH PACXO XIAI0ATEHTA HILKE 5 M/,

Jananme Ne 10 (pue. 1)

TIpeaycMOTpeTS: peryTHpoBaKKe Temneparypsi 8 peaktope 50 + 5 °C.; kon-
TpompoBasHe ypoBiA cpetsi B peaktope 1,2 + 0,2 M; KOHTPOTHPOBAHKE pacxota
HexoHoii eMecn Ha peaktop 12 + 13 M/ 1 cymMapHOro pacxosa XiazoareTa B
PpyGatky; GTOKHPOBKY NOTA4H HCXOTHOTO KOMTIOHEHTA i XTA/10QTCHTA NIDH MOBEI-
eHIH TemmepaTyphi B peakTope Bhme 55 °C.

Jananme Ne 11 (puc. 11)

TIpeaycMOTpET: PeryHpOBaKHE TeMIepaTyphi B peaktope 60 + 5 °C; kon-
TpompoBaKHe ypoBHA cpetsi B peaktope 1,2 + 0,2 M; KOHTPOTHPOBAHKE pacxota
‘HexoHOii euecH Ha peaktop 10 + 12 M/ 1 JaBICHIS X1A0ATEHTA NEEA PeaKTo-
ot 0,53 + 0,6 MITa; GroKMpOBKY 101 HCXOAHOIi CMECH  XTAZI0ATEHT Ha pe-
AKTOp IpH pacxolie HCXOaHOI cMecH Hike 10 /.
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Jananme Ne 12 (pue. 12)

Prtc. 12. TeXHOTOTIYECKAR CXEMA KOKYXOTPYGHOTO TEMI00GMEHHIKA

TIpeyCMOTPETS: PEryHpOBAHHE TEMMEPATYPE! CPEABI Ha BEIXOTE 3 TEMI0-
o6Menmika 65 + 5 °C; pery/poBanie pacxola HCXOAHOI CPEAs! HA TEILIOOGMEH-
ik 45 £ 5 M/a; KOHTPOIHPOBAHHE CYMMAPHOTO PACXOZA NIAPA HA TEILIOOGMEH-
HiK; GUOKHPOBKY NOA%H HCXOTHOH CPEZi M AP NpH MAZEHHH AGBTEHNS KA Na-
ponposoze e 0,5 MTa.

azanme Ne 13 (puc. 12)

TIpeyCMOTPETS: PEryMpOBAHHE TEMTEPATYPE! CPEABI Ha BEIXOTE 3 TEMI0-
oGmentnka 70 + 5 °C; pery mMpoBaHHe pacxola HCXOTHOI CPEAB HA TEMIO0GMEH-
itk 40 + 5 M*/u; KOHTPOIHPOBAHHE PACXOAA N1aPa Ha TeMIOOOMERHHK § + 10 M’/
‘GIIOKHPOBKY M7 HCXONHOF CMECH MPH NIAZIEHHH TEMIEPATYDE! Ha BHIXOTE Teri-
n00GMenHHKa HILKE 65 C.

ananme Ne 14 (puc. 12)

TIpeyCMOTPETS: PEryHpOBAHHE TEMTEPATYPE! CPEABI Ha BIXOTE 3 TEMI0-
o6menmika 75 + 5°C; perymupoBanie Pacxola HCXOHOI CPEIBI HA TEILIOOGMEH-
itk 80 + 5 M'/u; KOHTPOAMPORAHNE JaRneHis Ha naponposoze 0,3-0,4 MITa; Gio-
KHPOBKY TOZAH HCXOTHO CPEZSI W MApa MPH TIOHHAEHHH PACKOTA HCXOTHOI
CpeIbl Ha TEMIOBMEHHHK HIke 75 M/,
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Jananme Ne 15 (pue. 13)

Mapososayumas cxece.

e —
Kousepm-
pyewiii ras

L=

Konnepru-
pyesuii a3
Puc. 13. Ilaxtasiii peaktop sTopHuHOrO pchopMEra
MapoBOIyMHOfi KowBEpCHH MeTaa

TIpeycMOTpETS: PeryTHpOBaHHE PACXOTa MApOBOYIYIIHOI CMECH Ha peak-
Top 5000 £ 30 M*/4; KOHTPOAHPOBAHNE TEMNEPATYPEI KOHBEPTHPYEMOrO Ta3a Ha
Bxoae B peaktop (vensue 800 °C); GIOKHPOBK MOAAUM KOHBEPTHPYEMOTO raz
P KOHIEHTPAIIH METARA B KOHBEPTHPYEMOM rase Ha BEIXOZE Gobiie 5 6. %.

3ananme Ne 16 (puc. 13)

TIpeycMOTPETS: PeryTHpOBaHHE PACXOa MApOBOYIYIIHOF CMECH Ha Peak-
Top 2500 + 30 M*/4; KOHTPOIHPOBARNE KOHUCHTPALHI METAHA KOHBEPTHPYEMOrO
rasa Ha BIXOTE (MeRbie S 06. %) PeakTopa; GOKHPOBKY OAA4H NAPOBO3AYIIHOT

CMECH K PEAKTOp MPH TEMTEPATYPE KOHBEPTHPYEMOTO a3 Ha BXOZE B PEAKTOp.
o 800 °C.

3azanme Ne 17 (puc. 13)
TIpenycMOTpETS: PeryTHpOBaHHE PACXOTa MApOBOYIYIIHOF CMECH Ha Peak-
Top 2000 + 20 M'/4; KOHTPOTHPOBAHHE TEMIEPATYPEI NAPOBOYIIHOI CMECH Ha
BXOZE B peakTop (Menbine 482 °C); GIOKMPOBKY NMOJa4H KOHBEPTHPYEMOIO raa
P KOHIEHTPAIIH METAa B KOHBEPTHPYEMON rase a Bxoze Gosue 10 06. %.

3azanme Ne 18 (puc. 13)

TIpeyCMOTPETS: PeryTHpOBaHHE PACXOa MApOBOYIYIIHOF CMECH Ha peak-
op 3000 + 30 M*/1.; KOHTPOTHPOBAHHE KOHIEHTPALILI METAHA KOHBEPTHPYEMOrO
raza Ka BHXOAE (MEHbE 5 06. %) PeaKTopa; GIOKHPOBKY MOTA4H KOHBEPTHpYE-
MOTO a3 KA PEaKTOp MpH MePenaZie ARTEHHS KOHBEPTHPYEMOTO a%a Ha BXOTE 1
‘Bhixoze Menbie 0,9 Kre/os’.
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3ananme Ne 19 (puc. 13)

TIpeycMOTpETS: PeryTHpOBaHHE PACXOTa MApOBOYIYIIHOF CMECH Ha Peak-
Top 3500 + 35 '/u; KOHTPOIMPOBAHHE TEMNEPATYPEI NAPOBOYIIHOI CMECH Ha
‘BXOZ€ B peakTop (Menbine 482 C); KOHTPOTHPOBAHHE KOHICHTPAIMH METAHA KOH-
'BEPTHPYENOTO raza Ha BHIXOTE (MeHBIE S 0G. %) peaKTopa; GAOKHPOBKY nOTH
MAPOBOIIYIINON CMECH HA PEAKTOP MPH TEMMEPATYpE NAPOBOTYMIHON CMECH
o 482 °C

Jananme Ne 20 (puc. 14)

Jenvonse
Cns 1
e

Pic. 14. Tlews nepairarioro pudopssira

TIpenycMOTpETs: peryImpoBanue pacxona mMPHPOTHOTO rasa HA medh
40000 + 30 s*/u; KOHTPOTHPOBAHHE H CHPHATHIAIUS TEMNEPATYPHI JIMOBHIX Ta-
308 Ha BBIXOAE mewn 200260 °C; KonTpoIHpOBaHHE KoHUEHTPawH O B JbINMO-
BbIX rasax Ha BEXOTE Miew (MeHsize 0,6 06. %):; GTOKHPOBKY MOTAtH MPHPOTHOTO
a3a MPH OTCYTCTBINM AQBTEHNS B THHIK IOAATH PHPOTHOO Ta3a.

3ananme Ne 21 (puc. 14)

TIpenycMOTpETs: peryIHpoBanue pacxona mMPHPOTHOTO rasa HA medh
20000 + 20 3*/4; KOHTPOTHPOBAHHE TEMIEPATYPHI ABIMOBBIX FA30B Ha BEXOLE Tie-
wunt (menbine 260 °C); KOHTPOIS 32 CYMMapHbIM KOMHUECTBOM NPHPOTHOTO rasa
MOCTYNaIOEro B Meth; GIOKMPOBKY MOTAUH MPHPOTHOTO r43a HA EWh NPH KOk~
erTpaimi O, B 1e1MOBEIX rasax seie 0,5 % 06.

ananme Ne 22 (puc. 14)

TIpenycMOTpETs: | peryIHpoBanue pacxona mMPHPOTHOTO rasa HA medh
30000 £ 30 M*/u; KOHTpOHPOBatHE KOHIEHTPAIH O; B ABIMOBBIX FA3AX HA BEIXO-
e mewn (erute 0,4 0. %); GAOKHPOBKY MOZaNH NPHPOTHOTO Ta3a HA MEth TP
TeMIiepaType AbIMOBEIX razon B 260 °C.
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Jananme Ne 23 (puc. 15)

Tipenycmotpers: perymuposanme yposss 5 samte 1 500 £ 20 snt 3a cuer
"MOBEH HEXOIHOD PACTBOPA; PEryNMPOBAHHE TEMIIEPATYDH B BaHe — 160 £ 5 °C;
KOHTPOTHPOBAHHE 1 CYMMHDOBAHHE DACXORd TEMIOHOCHTENA TOTABAENOTO B
IMeCBIK BaHHI; GTIOKHPOBKY NIOTIAH HCXO/HOTO PACTBOPA MPH NAZIEHIH ABTIEHIS
Ha THHIK TIOTaM TenzoRoCHTes (ke 0,2 MTa).

Hexomii pacraop

Tenouocuten.

Pric. 15. TexHONOrHECKAS CXEMA BAHHS! HHKETHPOBAHHS

Jananme Ne 24 (puc. 15)

TipenycmoTpers: perymmposante yposis B Bastie 800 + 20 M 3a cueT o~
MAMH HEXQIHOTO PACTEOPE; ETYTHPOBAHME TeMNEPATYDH B Bathe — 160 £ 5 °C;
KOHTPOTHPOBAHHE  CHIHATH3AINA AQBIEHWS KA THHMH MOTAYH TEMTIOHOCHTENS

0.3 - 0.4 MTTa; G10K#pOBKY MOIA'H HEXOHOTO PACTROP MPH TEMTICPATYDE B
165°C.

3ananme Ne 25 (puc. 15)

TIpenyCMOTPETs: KOHTPOTHPOBAHHE M CHIHATHSALMIO YPOBHS B BaHHE
1500 + 20 My; perynpoBanue Temneparypei & Banie — 160 + 5 °C; konTpomipo-
BaHHE PACXOA TEIUIOHOCHTEIA B IMCBIIKE BAHHKI 2+3 M/1; GIOKHPOBKY NOZa‘H
HCXOTHOTO PACTBOPA M TEMLIOHOCHTEIA MW MATCHHN AQRTIEHNS B THHIH NIOTATH
renomocutens (ke 02 MITa).

3aname Ne 26 (puc. 15)

TIpenyCMOTPETS: KOHTPOTHPOBAHHE  CHIHATHSALMIO YPOBHA B BaHH
1500 £ 20 aw; perymnpoatite Temneparypei & Banie — 150 £ 5 °C; kontpomipo-
BAHHE CYMMAPHOTO PACXOTA TEMIOHOCHTENS NOCTYNAIOIIENO B SMCEBHK BAHHH;
‘GIIOKHPOBKY NOAQYH HEXOTHOTO PACTBOPA H TEIUIOHOCHTEIA TIDH MATEHIN AaBTE-
HUA B THHIH NOTQUH TerTOHOCHTEN (inke 0,2 MITa).
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Tun u ncnonHeHne HCX BbixogHoi | AunanasoH npeo6pasyembix Mpenen nonyckaemoi 3aBucuMocTb
Tepmonpeo6pasosatens curnan, mA | Temnepatyp, °C OCHOBHOW NPUBEAEHHO | BBIXOAHOrO curHana
norpewHocTu, vy, % OT TemMneparypbl
TXAY MeTpaH-271 K»? 4-20 -40...600, -40...800, -40...900, 0,5; 1,0 nuHenHas
-40...1000, 0...600, 0...800, 0...900,
0...1000, 400...900
TXAY MeTpaH-271-Exia -40...600, -40...800, -40...1000,
TXAY Merpan-271-Exd 0...600, 0...800, 0...1000
TCMY MeTpaH-274 100M 0-5 -50...100, -50...150, 0,25; 0,5 nuHenHasa
50M 4-20 -50...50, 0...50,
TCMY MeTpan-274-Exia 4-20 0...100, 0...150, 0...180
TCMY MetpaH-274-Exd
TCIY MeTtpaH-276 Pt100 0-5 4-20 -50...100, -50...150, 0...150, 0...50, 0,25; 0,5 nuHenHasa
TCNY MeTpan-276-Exia 2-20 -50...50, 0...100, 0...200, 0...300,

TCIY MeTpaH-276-Exd

0...400, 0...500
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PaGouee 3ajanne

MATLAB  H03B0JIS€T NPOBOMUTS B AMATOTOBOM PEKIME Bi3y-
IbHbIC HCCTICIOBANIS BO BPEMEHH (BU3YRTBHOE MPOrPAMMUPOBANHE)
XaPAKTEPHCTHK PA3MIMHBIX CHCTEM, C IOMOLLBHO MPOrPAMMHOFO MOZYIS
Simulink. TIpi 5ToM MOZemb HCCIIEAYEMOli CHCTEMBI pEACTABISETCS
B BILe CTPYKTYPHOI MOACTH 1 COXpAHSCTCS B (aiiie ¢ pacuuHpennes
slx (ans Gonee panminx seperii MATLAB — ¢ pacumpeniies .mdl).

Mogemn co3naiotes mo Texwonorui Drag-and-Drop (nepetsinit 1
OCTaBB) W3 OTACTBHBIX G7IOKOB (MOAy7eif). CaMit MO XpaHSTCS
B GuéamoTeRax mporpammmoro Moayns Simulink, KoTopeie mveioT
HEPAPXIYECKYIO CTPYKTYPY H MOFYT PACIIIHPSTHCS! [IOMB30BATEIEM 33 CHET
paspaGoT cOGCTRERHEIX G10K0B. TIpit STOM B 3ABHCHMOCTH OT 0COBCH-
HOCTCli MMHTAINH TPOLCCCOB pasmiuaior S-MoZemn i P-wozeni.
B S-MOJIISX BXOHBIC M BHIXOAHBIC BEMHHE HE MMEIOT (HH3ITECKOO
CONepAaHIIS, @ MHHIN COSAMHCHIS TEPCHOCST HEKOTOPBili HA(pOpMaLI-
OBl CHIHA. P-MOETH HMHTHPYIOT IPOIIECCEI B H/EKTPHHECKIX LETSX.

JUtst HAGIIOACHIS MOZETHPYEMBIX MPOIECCOB HCTIOMB3YIOTCS Clie-
wHanBRBE G10KH («OB30pHBIE OKHAY), BXOMALUE B COCTAB GHOMHOTER
Simulink.

1 3anycrums nporpasyy MATLAB i ¢ moMombio koMamst
Home=>New=>Simulink Model (;u1s Bepcitii ¢ MeHIo — 570 KOMaHa
File=>New=sModel) orkpits HoBoe myctoc okno untitled (picy-
HOK 1), B KOTOPOM GYJIET OCYIECTRISTECS CGOPKA S-MOEIIH.

BuiGpats B OTKkpEIBIICMCS OKHe Komanay File=Save As... i co-
xpaniTs haiin noz mvenes model_1 ma jicke B caocii marke.

2C novomsto xonkn B (13 neper ¢ wero — 970 KHonKa

) orxpums oxo GuomoTexn Simulink Library Browser (pucy-
HOK2), B JICBOM WACTH KOTOPOrO mpeAcTapieh mepesers Simulink-
GUOMHOTEK, BXOMUIX B COCTAB YCTAHOBMICHKOI KOHMIypaIit mpo-
rpammioro mozyns Simulink. B mpasoii wacti okma ha sakiake




